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Ubung 5-1
Installation von Linux
In dieser Ubung werden Sie auf Ihrem Server das Linux-Betriebssystem installieren, welches Sie fiir alle
weiteren Ubungen benétigen.
Vorgehensweise: Sie installieren auf dem Rechner, der lhnen zugewiesen wurde, das Linux Betriebs-
system der S.u.S.E.-Distribution 5.2.
Folgen Sie den nachfolgenden Anweisungen. |hr Dozent wird Ihnen weitere Informa-

tionen geben, die die spezielle Konfiguration des Kursraumes betreffen.

Voraussetzungen: - ein IBM-kompatibler PC 386, 486 oder Pentium, min. 8 MB RAM, min. 250 MB
freier Festplattenplatz (empfohlen: >2 GB)

1. Festhalten der Hardwarekonfiguration

Fir die Installation von Linux sollte man vor der ersten Installation die einzelnen Hardwarekomponenten in
einer Liste festhalten, um spater wahrend der Installation die richtigen Treiber auszuwahlen.

Erfragen Sie folgende Informationen von Ihrem Dozenten und notieren Sie sie:
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2. Legen sie die Installations-CD 1 der S.U.S.E-Distribution in das CD-Rom-Laufwerk und die Bootdis-
kette in das Diskettenlaufwerk lhres Servers.

Achtung: Entfernen Sie niemals den Schreibschutz dieser Diskette, da spéter Informationen zur Installation
auf eine Diskette gespeichert werden. Uberschreiben Sie nicht die Originaldiskette, sondern benutzen Sie
hierfiir eine neue.

3. Schalten Sie den Rechner ein. Von der Diskette wird jetzt ein Linux-Grundsystem gestartet, welches
das Installationsprogramm Yast enthalt.

4. Wahlen Sie mit [1] bzw. [1] die gewlinschte Sprache aus. Wahlen Sie Deutsch und driicken Sie [O].
5. Wahlen Sie den verwendeten Bildschirm aus. Wahlen Sie Farbbildschirm und driicken Sie [O].

6. Es erscheint jetzt eine andere Oberflache mit einem neuen Meni, dal Sie auffordert, lhre Tastatur-
belegung auszuwahlen. Wahlen sie auch hier Deutsch und bestatigen Sie mit [(].

7. Sie befinden sich nun im Installations-Hauptmenii . Hier haben Sie folgende Menupunkte zur Aus-
wahl:

e Einstellungen:
Andern von Sprache, Bildschirm, Tastaturbelegung, Debug (Experte)
e Kernel-Module (Hardware-Treiber):
Einbinden von speziellen Treibern und Modulen fiir die Installation. Festlegen der SCSI-Geréte, CD-
Rom-Treiber, Netzwerkkarten, PCMCIA-Module
Anzeigen der geladenen Module, Entfernen der geladenen Module, Automatisches Laden der Module
e System-Informationen;
Abfragen der vom System bereits ermittelten Hardwarekomponenten und installierten Treiber
¢ Installation / System starten:
Start der Installation
e Abbruch / Reboot

Waéhlen Sie den Menupunkt Kernel-Module (Hardware-Treiber) [O].
8. Wahlen Sie Automatisches Laden der Module [O] und warten Sie einen Moment. Es werden jetzt

die einzelnen Module fur die Hardwarekomponenten geladen. Nach jedem erfolgreichen Laden® eines
Moduls erscheint ein Meldung auf dem Bildschirm mit Angabe des Modulnamens:

! Solite ein Fehler auftreten, muR das Modul manuell eingebunden werden. Dazu den entsprechenden Meniipunkt auswahlen. Es
werden alle verfligbaren Module aufgelistet. Das der Hardwareliste entsprechende Modul auswéhlen. Bei der Option "Parameter fir
das Modul eingeben" nur bestatigen. Wurde das richtige Modul ausgewahlt, erscheint die Meldung ,Das Modul ,XYZ" wurde erfolg-
reich geladen®“. Wurde das falsche Modul ausgewahlt, erscheint die Meldung ,Laden des Moduls ,XYZ" ist fehlgeschlagen“. Neues
Modul auswahlen, bis es ohne Fehler geladen wurde.
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Beantworten Sie die Meldung "Das modul ,aic7xxx“ wurde erfolgreich geladen! Mdchten Sie nach
weiteren SCSI-Adaptern suchen?" mit NEIN.

Als néachstes werden die Module fur das CD-Rom-Laufwerk und die Netzwerkkarte geladen.

Am Ende werden alle geladenen Module angezeigt.

Alle geladenen Module kénnen ferner im Menupunkt ,Zeige geladene Module* angezeigt werden.

Wahlen Sie aus dem Hauptmenl Installation / System starten [[J]. Es erscheint folgendes Menu:

Installation starten
Installiertes System booten
Rettungssystem starten
CD-Rom Demo starten

Wahlen Sie den Menlpunkt Installation starten. Geben Sie als Quellmedium CD-Rom an und bestati-

gen Sie mit [(J]. Das CD-Rom wird gemountet und die Installation gestartet.

10.

11.

12.

Da Sie die Installation zum ersten Mal ausfiihren?, bestatigen Sie die Frage nach einer vorhandenen
Diskette mit Installations-Informationen mit NEIN [[T].

Linux erlaubt es Ihnen, eine sog. "Demo-Version™ zu installieren. Lehnen Sie ab und wahlen Sie fiir
ein Komplettsystem Normal aus.

Sie gelangen nun zum Hauptmenl des Installationsprogramms YaST (Yet another Setup Tool), wel-
ches aus folgenden Eintrédgen besteht:

Allgemeine Hilfe zur Installation und YaST-Tastaturbelegung
Detaillierte Beschreibung zu YaST

Einstellungen zur Installation
— Sprache festlegen
Auswabhl der Sprache, in der Linux installiert werden soll
— Tastaturbelegung auswéhlen
Auswabhl der landesspezifischen Tastaturbelegung (englisch, deutsch,...)
— Installationsquelle auswahlen
Auswahl, von welchem Medium Linux installiert werden soll *6
— Festplatte(n) partitionieren
— Ziel-Partitionen/Dateisysteme festlegen

2 Bej allen weiteren Durchlaufen legen Sie die entsprechende Diskette in das Diskettenlaufwerk und wahlen JA.
% Die Demoversion greift groRtenteils auf die zugehérige CD zu und ist nur fiir Test- bzw. Demonstrationszwecke sinnvoll.
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Festlegen der Mount-Points (Einhdngepunkte) des Dateisystems
» Installation festlegen/starten
* System updaten
» Backups erstellen
» README-Datei zum Installationsmedium anzeigen
»  Copyright
» Installation abschlie3en und YaST beenden

Wahlen Sie Einstellungen zur Installation und anschlieend Festplatte(n) partitionieren.

Partitionierung der Festplatte

Festplatten kénnen in sog. Partitionen unterteilt werden, die physikalisch voneinander getrennte Speicher-
bereiche darstellen. Sie kdnnen maximal vier sog. primére Partitionen anlegen. Fir mehr als vier vonein-
ander getrennte Bereiche mul3 spatestens die vierte Partition eine sog. erweitere Partition sein. In einer
erweiterten Partition kdnnen beliebig viele sog. logische Laufwerke angelegt werden.

ACHTUNG: Die Anderungen der Prtitionen werden erst wirksam wenn mit ,weiter* das Meni verlassen
wird und die darauf folgende Sicherheitsabfrage mit ,JA" bestétigt wird.

13. Legen Sie jetzt Ihre Partitionen an. Beachten Sie folgende Regeln bei der Festlegung der Partitionen:

- Die Linux-Systempartition sollte min. 400 MB grol3 sein. Teilen Sie diese Partition nur
in begrundeten Ausnahmeféllen in mehrere Partitionen auf.

4 Nur maoglich, wenn Linux nicht von der CD gestartet wurde
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- Richten sie eine Swap-Partition ein. Diese dient zum Auslagern von Informationen
wahrend des Betriebs von Linux und erhdht die Leistung des Systems. S.u.S.E. emp-
fiehlt eine GréRRe von 64 — 96 MB.

Achtung: Anderungen an der Partitionierung werden erst dann wirksam, wenn das Menti iber den Punkt
weiter verlassen wird und die darauf folgende Sicherheitsabfrage mit JA bestétigt wird.

a) Eventuell vorhandene Partitionen mit [F4] l6schen, bis der Text ,Keine Partitionen vorhanden® er-
scheint.

b) Drucken Sie [F5], um eine priméare Partition anzulegen. Wahlen Sie den ersten Partitionsnamen aus
dem Auswahlmenu (z.B.: /dev/sdal).

c) Inder folgenden Maske wird die GroR3e der Partition festgelegt. Der Wert flr den Startzylinder ist 1.
Fur das Ende der Partition geben Sie die GréRe in MB gemaR folgender Notation ein : +1000M fir ei-

ne 1 GB groR3e Partition.

d) Nach dem Anlegen der primaren Partition legen Sie auf die gleiche Weise fur den restlichen Platz auf
der Festplatte eine erweiterte Partition an. Diese erscheint mit dem Vermerk Extended.

e) Markieren Sie die erweiterte Partition und legen Sie hierin mit [F5] ein logisches Laufwerk fir die
Swap-Partition an. Gré3e: 96 MB.

f) Setzen Sie den Typ dieser Partition mit [F3] auf ,Linux Swap Partition*.

g) Verlassen Sie das Menl mit Weiter und tragen Sie die geanderten Partitionen auf Ihrer Festplatte ein,
indem Sie die nachfolgende Sicherheitsabfrage mit Ja bestétigen.
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Mount-Points festlegen

14. Nach der Partitionierung der Festplatten gelangen Sie wieder in das YaST Meni Einstellungen zur
Installation. Wahlen Sie jetzt Ziel-Partitionen / Dateisysteme festlegen.

15. Alle angelegten Dateisysteme werden angezeigt. Um die einzelnen Dateisysteme ansprechen zu kdn-
nen, missen Ilhnen sog. Mount Points (Einhdngepunkte) zugewiesen werden.
Die Installationspartition muf3 den Mount Point " /" besitzen. Dies ist die Spitze des gesamten Da-
teisystems und hei3t daher auch root’ . Wahlen Sie die priméare Partition aus, die Sie in Schritt 13b)
far Linux angelegt haben, und setzen Sie mit [F4] den Mount Point auf " /.

16. Die neu angelegte Partition muf3 vor der Installation formatiert werden. Driicken Sie dazu [F6] und
wahlen Sie die Art der Formatierung. Wéhlen Sie ohne Priifen .

17. Verlassen Sie das Meni mit Weiter und bestéatigen Sie die folgende Sicherheitsabfrage zum Anle-
gen der Dateisysteme mit Ja.

18. Die Dateisysteme werden jetzt angelegt. Nach erfolgreichem Anlegen befinden Sie sich wieder im
YaST-Meni Einstellungen zur Installation. Verlassen sie dieses Unterment mit [ESC].

Linux Grundsystem installieren

19. Wéhlen Sie aus dem HauptmenU Installation festlegen / starten aus.

20. Sie befinden sich jetzt im Menu fur die Paket-Auswahl des Linux Systems, das folgende Eintrage
enthalt:

® root (engl.) = Wurzel
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» Konfiguration laden

» Konfiguration speichern

» Konfiguration andern/erstellen

» Paketabhangigkeiten Uberprifen
*  Was ware wenn...

* Installation starten

e Index aller Serien und Pakete
» Paketauskunft

* Pakete einspielen
* Pakete léschen
* Hauptmenu

21. Die Konfiguration ,default wird automatisch geladen. Fiigen Sie jetzt iiber den Menupunk Konfigura-
tion laden die Konfiguration InterSrv * Internet access server system hinzu.

22. Starten Sie die Installation mit Installation starten. Das Linux System wird jetzt auf die Partition ko-
piert.

Achtung: Bei der ersten Installation kann YaST nur die Pakete der ersten CD-ROM installieren. Alle weite-
ren Pakete werden nach einem Neustart des Systems installiert. Dies wird von YaST automatisch durch-
gefiihrt.

23. Gehen Sie zuriick zum Hauptmeni und verlassen Sie YaST uber Installation abschlieRen und
YaST beenden .

Installation des Kernels
24. Nach Beendigung der Installation wird der Bootkernel installiert. Achten Sie darauf, ob sich in Ihrem
System ein SCSI-Kontroller befindet und wéahlen Sie den Kernel aus, der lhren Kontroller unterstitzt

(Sie haben ihn in Schritt 1 notiert).

25. Nach der Installation haben Sie die Mdglichkeit, eine Bootdiskette erzeugen zu lassen. Akzeptieren
Sie und verwenden Sie nicht die S.u.S.E.-Installationsdiskette, sondern eine neue Diskette.
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Konfiguration des Bootmanagers Lilo

Lilo ist ein Bootmanager, den Linux zum direkten® booten bendtigt. Er erlaubt u.a., beim Booten zwischen
verschiedenen Kerneln” auszuwahlen.

26. Wahlen Sie zur LILO-Installation Ja und driicken Sie [F4].

27. Es erscheint eine Eingabemaske, in der Linux als Bootkonfiguration eingetragen werden muf3. Geben
sie hierfur unter Name der Konfiguration "Linux" ein und bestatigen alle weiteren Angaben mit [[].

28. Im unteren Fenster erscheint jetzt die eingetragene Konfiguration Linux. Belassen Sie alle weiteren
Angaben und verlassen die Maske mit weiter. Der Lilo-Bootmanager wird daraufhin installiert.

Einstellungen zum Linux System

29. Nach der Lilo-Konfiguration werden Sie aufgefordert, die Zeitzone auszuwahlen. Mit den Pfeiltasten
und den Bild-Steuerungstasten kdnnen Sie durch die Auswabhlliste blattern. Markieren Sie Euro-
pe/Berlin und bestatigen Sie mit [O].

30. Im nachsten Punkt wird festgelegt, wie die Hardwareuhr Ihres Rechnes eingestellt ist (Greenwich
Mean Time oder Lokale Zeit). Wéhlen Sie Lokale Zeit.

Netzwerkkonfiguration

Es folgen einige Masken zur Netzwerkkonfiguration des Rechners.

31. Geben Sie als erstes den Rechnernamen (z.B. serverX) und den Domainnamen (z.B.:
alf.es.bw.schule.de) ein, die Sie in Schritt 1 notiert haben.

32. Nun kdnnen Sie festlegen, ob Sie ein sog. Loopback8 oder ein echtes Netzwerk verwenden. Wahlen
sie Echtes Netzwerk.

Es folgt eine Maske, in der Angaben zur Netzwerkkarte gemacht werden mussen.
33. Wabhlen Sie als Typ des Netzwerkes Ethernet.
34. Geben Sie anschlieRend die TCP/IP-Parameter ein, die Sie sich in Schritt 1 notiert haben:

a) IP-Adresse ihres Rechners (z.B. 134.108.233.242),

® Wenn sich DOS/Windows auf dem Rechner befinden, kann indirekt tiber LOADLIN gebootet werden.
7 Mit Lilo kénnen sogar verschiedene Betriebssysteme gestartet werden!
8 Schleife zu sich selbst = simuliertes Netzwerk
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b) Netmask (z.B. 255.255.255.0),

c) Gateway-Adresse (die IP-Adresse des Cisco-Routers in lhrem Haus).

Bestétigen Sie abschlieRend mit Weiter.

Weitere Dienste

Nach der Netzwerkkonfiguration, werden weitere Dienste von Linux eingerichtet.

35.

36.

37.

38.

39.

40.

Als erstes kénnen Sie den Internet-Damonen inetd installieren. Dieser Dienst ist wichtig, wenn von
anderen Rechnern auf den Linux Rechner zugegriffen werden soll. Antworten Sie mit JA.

Der portmap-Dienst sollte ebenfalls installiert werden. Antworten Sie mit JA.

Die Frage, ob der Rechner als NFS-Server dienen soll, beantworten Sie ebenfalls mit JA.

Ihnen wird nun angezeigt, wie sich der Rechner bei der Benutzung von Mail und News im Netz identi-
fiziert. Bestatigen Sie dies, ohne Anderungen vorzunehmen.

Bestétigen Sie die Frage, ob Sie auf einen Nameserver zugreifen wollen, mit JA und geben Sie in der
folgenden Eingabemaske die IP-Adressen des/der Nameserver ein (z.B.: 129.143.2.4), die Sie in
Schritt 1 notiert haben. Sie haben die Mdglichkeit, bis zu drei IP-Adressen anzugeben. Trennen Sie
diese durch ein Leerzeichen.

Sendmail-Konfiguration
Sie haben hier folgende Auswahl:
- Anschlu3 ans Netz mit Zugriff auf Nameserver

- Benutze UUCP zur Mailtibertragung
- Installiere /etc/sendmail.cfg nicht

Wahlen Sie Anschlul3 ans Netz mit Zugriff auf Nameserver

41.

42.

Nun wird das System konfiguriert und ein Script ausgefuhrt. Die entsprechenden Meldungen sehen
Sie in einem Fenster.

Sie gelangen abschliel3end zuriick zum Installationsprogramm und das System wird neu gebootet.
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Erster Start des installierten Systems

43. Nach dem Rebooten werden Sie aufgefordert, ein Passwort fur den Benutzer ,root* einzugeben. Die
Benutzerkennung ,root* bezeichnet den Systemadministrator und dient nur der Systemverwaltung.

Wahlen Sie in dieser Ubung als PaRwort LinuxX.

Achtung: Verwenden Sie ein Pal3wort, das Sie sich leicht merken kénnen. Sollten Sie das root-Pal3wort
vergessen, kénnen Sie am System keine Anderungen mehr vornehmen und miissen es im ungiinstigsten

Fall vollsténdig neu installieren. Ihre Daten kénnen dabei verloren gehen!

44. Beantworten Sie die Frage, ob Sie besondere Bildschirmfonts ausprobieren méchten, mit NEIN.
45. Beantworten Sie die Frage, ob Sie einen Beispielbenutzer anlegen wollen, mit NEIN.

46. Beantworten Sie die Frage, ob Sie ein Modem einrichten wollen, mit NEIN.

47. Beantworten Sie die Frage, ob Sie Ihre Maus konfigurieren mdchten, mit JA.
a) Es erscheint eine Auswahlliste verschiedener Maus-Typen (Microsoft, Logitech,...). Markieren Sie
den entsprechenden Typ Ihrer Maus und bestatigen Sie mit [[].

b) Geben Sie als Schnittstelle der Maus an: Standard: ttySO — com1: unter DOS

c) Beantworten Sie die Frage Gpm benutzen? mit JA.
d) Testen Sie Ihre Einstellungen. Bewegen Sie die Maus. Wenn Sie einen Mauszeiger erkennen kon-

nen, ist die Konfiguration korrekt.

48. AnschlieRend wird automatisch YaSt gestartet, um die noch fehlenden Pakete der CD’s 2 und 3 zu

[]

installieren. Befolgen sie die Anweisungen auf Ihrem Bildschirm.
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Ubung 5-2
Einbau einer zweiten Netzwerkkarte

In dieser Ubung werden Sie in Ihren Server eine zweite Netzwerkkarte einbauen und konfigurieren.

Vorgehensweise: Sie bauen in den Rechner, der Ihnen zugewiesen wurde, eine zweite Netzwerkkarte
ein und konfigurieren das Betriebssystem, so dal3 beide Netzwerkkarten verwendet
werden kdnnen.
Folgen Sie den nachfolgenden Anweisungen. |hr Dozent wird Ihnen weitere Informa-
tionen geben, die die spezielle Konfiguration des Kursraumes betreffen.

Voraussetzungen: - ein Linux-Rechner mit funktionierender Netzwerkanbindung
- eine zweite Netzwerkkarte
- der Kernel muf3 das Routing unterstitzen (default bei S.u.S.E. Linux 5.2)

Achtung: Das Ansprechen zweier Netzwerkkarten ist unter Linux nicht trivial. Verwenden Sie mdglichst
keine identischen ISA-Karten, sondern Karten, die verschiedene Treibermodule bendtigen (z.B. NE2000
und 3COM). Ebenfalls erfolgversprechend sind PCI-Netzwerkkarten. Bemiihen Sie jedoch vor einer Neu-
anschaffung die S.u.S.E.-Support-Datenbank, ob die betreffenden Karten von Linux unterstiitz werden!
Wenn Sie die Konfiguration "Internet Access Server” installiert haben, wird ein Teil dieser Support-
Datenbank als HTML-Dokumentensammlung von lhrem Apache-Webserver zur Verfiigung gestellt.

1. Erfragen Sie folgende Hardware-Informationen von lhrem Dozenten:

[ LA 010 oA I (=T o 1= SO PSP PUP PP TTPPT

11 C=T (0 o o (L ) TS PP PP PPTRPTPPP

Tz 1< 1L T

Achtung: Ihre beiden Netzwerkkarten miissen verschiedene Ressourcen belegen, d.h. IRQ und I/O miis-
sen sich voneinander unterscheiden und dlirfen in keinem Adrel3-Konflikt mit anderen Geréten im System
stehen! Sie miissen ggf. die zweite Karte mit der vom Hersteller mitgelieferten Software umkonfigurieren
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2. Erfragen Sie die geplante Netzkonfiguration der zweiten Karte von Ihrem Dozenten:

YU o] 1] o T SRS URRPR
L= 1= | PO PP PP PPRPPPRPRR
3. Starten Sie auf Threm Server Linux. Melden Sie sich als Benutzer root an. Das Pal3wort lautet linux.
4. Starten Sie X-Windows durch Eingabe von startx [O].
5. Uberpriifen Sie die Parameter der ersten Netzwerkkarte wie folgt:

- Geben Sie folgendes Kommando im Fenster eines XTerminals ein: ifconfig —a [ O].
Hierdurch wird Ihnen die aktuelle Netzkonfiguration mitgeteilt, z.B.:

et hO Li nk encap: 10Mops Et hernet HWaddr 00: 80: 48: B9: 02: 53
inet addr:172.30.1.1 Bcast:172.30.1.255 Mask: 255.255.255.0
UP BROADCAST RUNNI NG MULTI CAST MrIU: 1500 Metric:1
RX packets: 591541 errors: 0 dropped: O overruns: O
TX packets: 36738 errors: 0 dropped: 0 overruns: 0
Interrupt: 10 Base address: 0x300

— Notieren Sie diese Informationen, um festzustellen, ob lhre zweite Karte mit obigen Parametern kolli-
diert:

1 N

IRQ: oottt e e e e e e et e e e et e et ee et e et ettt e sttt e e et e ettt ettt e ettt

| N [ =YY=

Tip: Um allgemein die Konfiguration der verwendeten Hardware zu Uberprifen, wechseln Sie

@ ins Verzeichnis / pr oc und schauen sich mit einem Editor die Dateien i oports, inter-
rupts, undpci an. Die Datei nodul es zeigt Ihnen dartiberhinaus die geladenen Module,
z.B. fur die Netzwerkkarten.
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Tip: Wenn Sie wissen wollen, ob Ihr System die verwendete Hardware (z.B. Netzwerkkarte) richtig er-
kannt hat, schauen Sie einfach in der Systemdatei /var/log/messages nach, die u.a. die Meldungen beim
Hochfahren des Linux-Systems enthalt:

- Starten Sie den Editor Xcoral Uber Mausklick mit der rechten Maustaste auf den Bildschirmhintergrund
- Editoren - TextEditoren - Xcoral.

— Klicken Sie mit der linken Maustaste auf File > Read File.

— Geben Sie ins Feld File name ein: /var/log/messages [0]

- Hier finden Sie die Meldungen Uber geladene Module, z.B. fir eine NE2000-kompatible Netzwerkkarte:

Jun 12 13:08: 15 server kernel: |oading device 'ethO ...

Jun 12 13:08:15 server kernel: ne.c:v1l.10 9/23/94 Donal d Becker (bek-

ker @esdi s. gsf c. nasa. gov

Jun 12 13:08:15 server kernel: NE*00O ethercard probe at 0x300: 00 80 48 b9

02 53

Jun 12 13:08: 15 server kernel: ethO: NE2000 found at 0x300, using |IRQ 10.

- Schlie3en Sie Xcoral Uber File = Quit.

6. Uberpriifen Sie, ob Probleme mit der zweiten Netzwerkkarte bekannt sind. Verwenden Sie hierfiir den
lokal auf Inrem Server liegenden Teil der S.u.S.E.-Support-Datenbank, der in Form von html-
Dokumenten von lhrem lokalen Webserver apache zur Verfigung gestellt wird:

- Geben Sie im Fenster eines XTerminals ein: arena http://localhost &

Hierdurch starten Sie den Webbrowser arena (Netscape ist (noch) nicht installiert), geben als Ziela-
dresse den eigenen Rechner an und verbannen den Prozel} in den Hintergrund (&).

- Klicken Sie auf Das SuSE-Hilfesystem finden Sie [...] hier: Deutsch

- Klicken Sie auf Support-Datenbank — lokal

— Klicken Sie auf Stichwortsuche und geben Sie den Namen der Karte ein, z.B. 3c905.

— Lesen Sie die bekannten Probleme und verfolgen Sie ggf. die Verweise in der Zeile Stichwdrter .

— Eine Datenbank Uber die gesamte von SUSE-Linux unterstitze Hardware finden Sie auf der
Webseite

http://ww. suse. de/ cdb/ deut sch
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Beenden Sie arena, driicken Sie [(J] und fahren Sie Ihren Server herunter mit dem Kommando
shutdown —h now [ []

Schalten Sie den Rechner aus, 6ffnen Sie Ihn und stecken Sie die zweite Netzwerkkarte in einen frei-
en Slot auf dem Mainboard. SchlieRen Sie den Rechner, schalten Sie Ihn ein und starten Sie Linux.
Melden Sie sich als root an und starten Sie XWindows.

Starten Sie YaST durch Eingabe von yast [O].

Wahlen Sie Administration des Systems - Hardware ins System integrieren > Netzwerkkarte
konfigurieren.

Dricken Sie im Feld Typ des Netzwerks die Taste [F3]. Wahlen Sie eth1 [(] und gehen Sie mit der
Taste [1] ins nachste Eingabefeld.

Waéhlen Sie im Feld Art der Netzwerkkarte den Kartentyp aus, den Sie sich in Schritt 1 notiert haben.
Geben Sie im Feld Optionen zum Laden des Moduls ggf. weitere Parameter ein. Tip: Lassen Sie
die Vorgabe unverandert und tragen Sie evtl. notwendige Parameter spéter in der Datei

/etc/conf.modules ein.

Gehen Sie mit der Taste [1] ins Feld <Weiter> und driicken Sie [[J]. Driicken Sie sooft [Esc], bis Sie
Yast verlassen.

Ihre beiden Netzwerkkarten sind nun in der Datei /etc/conf.modules eingetragen. Uberpriifen Sie die
entsprechenden Eintrage in dieser Datei. Starten Sie den Editor Xcoral Gber Mausklick mit der rech-
ten Maustaste auf den Bildschirmhintergrund - Editoren > TextEditoren - Xcoral.

— Klicken Sie mit der linken Maustaste auf File > Read File.

— Geben Sie ins Feld File name ein: /etc/conf.modules [[]

- Die Datei muR die Eintréage alias ethO [...] und alias eth1 [...] enthalten. Wenn zum erfolgreichen
Erkennen der Karten irgendwelche Optionen angegeben werden missen (fir 3COM905 ist dies nicht
erforderlich!), entfernen Sie im Abschnitt # Options; das Kommentarzeichen # vor dem entsprechen-
den Modul und tragen den/die Parameter ein. Beispiel:

# Aliases - specify your hardware

alias ethO ne
alias ethl 3c505
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# Options; these are exanpl es; uncomrented and nodify the |ines you need

options ne i 0=0x300
options 3c505 i 0=0x210 irqg=5

- Speichern Sie die Datei tber File > Save file und verlassen Sie Xcoral Uber File > Quit.

Starten Sie Yast durch Eingabe von yast [O].

Wahlen Sie Administration des Systems - Netzwerk konfigurieren - Netzwerk Grundkonfigu-
ration.

Gehen Sie mit der Taste [{] ins Feld [1] und driicken Sie [F5]. Wé&hlen Sie Ethernet [[].

Dricken Sie [F6] und geben Sie die IP-Adresse sowie die Subnet-Mask ein, die Sie sich in Schritt 1
far die zweite Netzwerkkarte notiert haben. Lassen Sie den Eintrag def aul t 134. 108. 233. 129
stehen. Verlassen Sie das Dialogfeld mit <Weiter>.

Aktivieren Sie die Karte mit [F4]. Verlassen Sie das Menu mit [F10]. Es startet SUSE-Config, um lhr
System zu aktualisieren. Wahlen Sie abschlieend <Weiter> und verlassen Sie Yast durch mehrfa-
ches Driicken von [Esc].

Da sich nun zwei Netzwerkkarten in Ihrem System befinden, hat Yast automatisch das sog. Routing
(Weiterleiten von IP-Datenpaketen von einer Karte zur anderen) konfiguriert. Uberpriifen Sie die Ein-
stellungen durch Editieren der Datei /etc/route.conf:

- Starten Sie Xcoral, laden Sie Uber File > Read file die Datei /etc/route.conf. Diese Datei darf nur
drei Eintrédge enthalten, die nicht mit einem '# auskommentiert sind und muf3 in etwa wie folgt ausse-

hen:

# /etc/route.conf

#

# In this file you can configure your static routing...

#

# This file is read by /sbin/init.d/route.

#

#

# Destination Dunmy/ Gat eway Net mask Devi ce
#

134.108.233.0 0.0.0.0 255. 255, 255. 128 et hO
172.30.1.0 0.0.0.0 255. 255. 255. 0 ethl
def aul t 134.108. 233. 129

- In dieser Datei wird spezifiziert, tiber welches Device (hier: Netzwerkkarte) Datenpakete versendet
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werden mussen, die als Zieladresse einen Rechner im Netz '134.108.233.0" bzw. '172.30.1.0" aufwei-
sen. Der eigene Rechner bildet hierfur die 'default route' 0.0.0.0, da er als Gateway zwischen den ver-
schiedenen Netzen arbeitet. Fiur alle anderen Ziele aul3er den beiden genannten Netzen gilt der Ein-
trag def aul t . Hier ist die IP-Adresse des Cisco-Routers in lhrem Haus eingetragen, tber den alle

anderen Datenpakete versendet werden.

Achtung: Im Feld 'Destination’ wird die IP-Adresse des betreffenden Netzes, nicht der Karte eingetragen
(erkennbar an der abschlieSenden '0’). Achten Sie darauf, dal3 Sie die Netzwerknummer dem richtigen
Device (Netzwerkkarte) zuordnen. I.d.R. werden Sie die erste Karte ethO mit dem Internet bzw. Cisco-
Router verbinden und ihr eine ‘echte’, vom BelW!i zugeteilte IP-Adresse zuweisen. Die zweite Karte eth1
wird mit Ihrem lokalen Netz verbunden, welches freie (nicht routbare) Adressen verwendet.

22. Finden Sie in der Datei /etc/route.conf weitere, nicht auskommentierte Eintrage, so I6schen Sie sie.
Diese wurden falschlicherweise von Yast angelegt.

23. Speichern Sie die Datei /etc/route.conf Uber File - Save file und beenden Sie Xcoral tber File >

Quit.

24. Meistens wird es notig sein, dem Linux-Kernel mitzuteilen, daf’ er beim Booten zwei Netzwerkkarten
erkennen soll. Dies erreichen Sie durch einen entsprechenden Eintrag in der Datei /etc/lilo.conf.

— Starten Sie Xcoral und laden Sie die Datei /etc/lilo.conf.
— Fugen Sie Uber der Zeile# End LI LO gl obal section folgende Zeile ein:
append = "et her=0, 0, ethl"”

Durch die Nullen wird eine automatische Erkennung der Kartenparameter veranlaf3t, wahrend der Pa-
rameter ‘ethl’den Kernel zum Suchen nach der zweiten Netzwerkkarte ethl auffordert.

— Speichern Sie die Datei /etc/lilo.conf Uber File > Save file und beenden Sie Xcoral Uber File >

Quit.

— Damit die neue Konfiguration an den Lilo Ubergeben wird, geben Sie folgendes Kommando ein:

lilo [O]
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Nun ist Ihre Konfiguration vollstandig. Starten Sie Ihren Rechner neu, damit die zweite Karte mit den
eingestellten Parametern ins System eingebunden wird. Geben Sie ein:

reboot [O].

Wenn der Rechner wieder hochgefahren ist, melden Sie sich als root an und starten Sie Xwindows.
Geben Sie folgendes Kommando ein:

ifconfig —a [ O]

Wenn beide Netzwerkkarten korrekt eingebunden sind, erhalten Sie fiir jedes Device (ethO und ethl)
eine entsprechende Ubersicht. Diese konnte z.B. wie folgt aussehen:

et hO Link encap: 10Mips Ethernet HwAaddr 00: 80: 48: B9: 02: 53
i net addr: 134.108.233.211 Bcast:134. 108. 233. 255 Mask: 255. 255. 255. 128
UP BROADCAST RUNNI NG MULTI CAST MrU: 1500 Metric:1
RX packet s: 55898 errors: 0 dropped: 0 overruns: 0
TX packets: 14494 errors: 0 dropped: 0 overruns: 0
Interrupt: 10 Base address: 0x300

ethl Link encap: 10Mops Ethernet Hwaddr 00: 60: 08: 31: 40: 1C
inet addr:172.30.1.1 Bcast:172.30.1.255 Mask: 255.255.255.0
UP BROADCAST RUNNI NG MULTI CAST MIU: 1500 Metric:1
RX packets: 53690 errors: 0 dropped: 0 overruns: 0
TX packets: 16567 errors: 0 dropped: 0 overruns: 0
Interrupt:3 Base address: 0x210

Sollte Ihre zweite Karte nicht korrekt arbeiten, schauen sie sich die Meldungen beim Systemstart an.
Diese werden in der Datei /var/log/messages mitprotokolliert (siehe Tip unter Punkt 5!)

Durch den Einbau einer zweiten Netwerkkarte kann Linux nicht wissen, welche (physikalische) Netz-
werkkarte als Device et h0, und welche als et h1l angesprochen werden soll. In der Regel wird dieje-
nige Karte mit dem niedrigeren Interrupt bzw. Base-I/O als et hO angesprochen. Hierdurch kann lhre
Konfiguration vertauscht sein, wenn die zweite Karte den kleineren Interrupt verwendet. Uberprii-
fen Sie die Konfiguration durch wiederholte Eingabe von ifconfig —a [ [].

— Wenn der Wert RX fir empfangene Datenpakete der zweiten Karte (et h1) standig zunimmt, obwohl
diese Karte noch nicht mit dem Netzwerk verbunden ist, wurden die Karten von Linux vertauscht.
Wenn beide Karten mit demselben Treiber betrieben werden, vertauschen Sie einfach das Netz-
werk-Anschlu3kabel .

— Wenn Sie verschiedene Treiber fur die beiden Karten verwenden, missen Sie in Yast die Netz-
werkkonfiguration (IP-Adressen + Subnet-Mask) fiir et hO und et h1 vertauschen. Fuhren Sie hier-
fur die Schritte 17) bis 19) erneut, jedoch mit vertauschter Konfiguration, aus.
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Ubung 5-3
Aktivierung des IP-Masquerading

In dieser Ubung werden Sie auf Inrem Server das IP-Masquerading aktivieren.

Vorgehensweise: Sie aktivieren auf dem Linux-Server, der Ihnen zugewiesen wurde, das IP-
Masquerading.
Folgen Sie den nachfolgenden Anweisungen. Ihr Dozent wird Ihnen weitere Informa-
tionen geben, die die spezielle Konfiguration des Kursraumes betreffen.

Voraussetzungen: - ein Linux-Rechner mit zwei Netzwerkkarten und funktionierender Netzwerkanbin-
dung
— aktiviertes und konfiguriertes Routing Uber die beiden Netzwerkkarten
- installiertes Paket firewall aus der Serie n (in der installierten Konfiguration Inter-
net Access Server bereits enthalten)
- der Kernel mul3 das Masquerading unterstitzen (default bei S.u.S.E. Linux 5.2)

1. Melden Sie sich als root an und starten Sie Xwindows Uber startx [].

2. Starten Sie den Editor Xcoral.

3. Laden Sie die Datei /etc/rc.config.

4. Begeben Sie sich in den Abschnitt mit den folgenden Eintragen:

Masquer adi ng settings - See /usr/doc/ packages/firewall
for a detailed description

M5Q_START="no"

M5Q_NETWORKS="192. 168. 0. 0/ 24"

M5Q _DEV="et h0O"
MSQ MODULES="i p_rmasq_cuseene i p_masqg_ftp ip_nmasq_irc i p_masq_quake

H OHF OH OHF OH OH O

i p_masqg_raudio i p_nmasqg_vdolive"
#

5. Léschen Sie — sofern vorhanden - die Kommentarzeichen '#' vor den Eintragen
MSQ START
MSQ_NETWORKS
M5Q _DEV



10.

11.

UBUNG 5-3 A U2

Multitmedi@
Schule

MSQ MODULES

Andern Sie den Parameter MSQ _START auf folgenden Wert:

MBQ START="yes"

Andern Sie den Parameter MSQ NETWORKS auf die Netzwerknummer und Subnet-Mask Ihres inter-
nen Netzes. Sie haben hierfiir in den vorangegangenen Ubungen die zweite Netzwerkkarte eth1 ein-
gebaut und Ihr in Ubung 5.2 eine IP-Adresse zugeteilt. Tragen Sie die Netzwerknummer ein, die Sie in
Ubung 5-2, Schritt 2 notiert haben. Achten Sie darauf, daR die Netzwerknummer auf '0' endet!
Beispiel: Wenn Sie der zweiten Karte die IP-Adresse 172.30.1.1 / Subnet 255.255.255.0 zugeteilt
hétten, lautet der korrekte Eintrag

M5Q_NETWORKS="172. 30. 1. 0/ 255. 255. 255. 0"

Vergewissern Sie sich, dal3 Ihre erste Netzwerkkarte ethO mit dem Internet bzw. Cisco-Router ver-
bunden ist. Auf diesem Device findet das IP-Masquerading statt. Der korrekte Eintrag hierfir ist

MSQ DEV="et h0O"
Nicht alle Protokolle kommen damit zurecht, daf? die Absender-IP-Adresse in den Paketen einfach
ersetzt wird. Aus diesem Grund kénnen fiir diverse Protokolle verschiedene Module in den Kernel ge-

bunden werden. Dies erreichen Sie durch die Eintrage

MBQ MODULES="i p_masqg_cuseene ip_masq_ftp ip_nmasqg_irc ip_masq_quake
i p_masqg_raudi o i p_masqg_vdolive"

Speichern Sie die geanderte Datei / et ¢/ r ¢c. confi g, beenden Sie Xcoral und starten Sie Ihren Ser-
ver neu. Geben Sie ein reboot [].

Beim nachsten Systemstart wird nun das Masquerading aktiviert. Uberpriifen Sie dies durch Eingabe
von

/sbin/init.d/masquerade list [(]

Sie missen u.a. die Eintrage

i f nanme sour ce
et hO 172.30.1.0
vorfinden.
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Ubung 6-1
TCP/IP-Konfiguration der Client-PC's

In dieser Ubung werden Sie lhren Client-PC (Windows 95 Arbeitsstation) fiir die Verwendung von TCP/IP
konfigurieren, mit Ihrem Linux-Server verbinden und die TCP/IP-Konfiguration testen.
Vorgehensweise: Sie konfigurieren auf der Windows 95 Arbeitsstation, die IThnen zugewiesen wurde,
das TCP/IP-Protokoll und verbinden sie mit Ihrem Linux-Server.
Folgen Sie den nachfolgenden Anweisungen. Ihr Dozent wird Ihnen weitere Informa-
tionen geben, die die spezielle Konfiguration des Kursraumes betreffen.
Voraussetzungen: - Windows 95 oder Windows NT
— die zugehdrige Installations-CD

1. Starten Sie Windows 95 und melden Sie sich unter der Benutzerkennung weber an.

2. Klicken Sie mit der rechten Maustaste auf das Symbol Netzwerkumgebung auf Inrem Desktop und
wahlen Sie den Unterpunkt Eigenschaften.

3. Kilicken Sie auf der Seite Konfiguration auf Hinzuflgen...
4. Klicken Sie auf Protokoll und anschlieend auf Hinzufigen...

5. Klicken Sie in der linken Fensterhalfte auf Microsoft und anschlieRend in der rechten Fensterhalfte
auf TCP/IP. Bestétigen Sie mit OK.

6. Klicken Sie auf der Seite Konfiguration auf die soeben hinzugefiuigte Zeile TCP/IP.
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Menil Eigenschaften fiir TCP/IP tragen Sie

UBUNG 6-1

Eigenschaften fiir TCP/IP [7] ] Klicken Sie Eigenschaften. Im folgenden
Bindungen I Enweitert I DM S-Fonfiguration |
Gateway I NS -K onfiguration IP-Adresse

Diezem Computer kann automatizech eine IP-Adiezse
zZugewiesen werden. Wenn im Metzwerk 1P-Adressen nicht
automatizch vergeben werden, fragen Sie den
Metzwerkadministrator nach einer Adresse, und geben Sie
dieze unten ein.

" |P-Adiesze automatisch beziehen

IP-Adiesze:

[172.30. 1 .11 |

SubnetMask: |255.255.255. 0 |

ak. I Abbrechen

Zu Punkt 7 a): Tragen Sie auf der Seite 'IP-Adresse’ eine

bisher nicht verwendete IP-Adresse in lhrem lokalen Netz ein.

Eigenschaften fiir TCP/IP HE

DMS-Konfiguration
|IP-4drezze

Bindungen I Enweitert I
Gatewray | WINS-Kanfiguration |

Der erste Gateway in der Liste der installierten Gateways ist der
Standard-G ateway. Die Reihenfolae in der Liste entspricht der
Reihenfolge, in der diese Computer venwendet werden,

Meuer Gateway:

172.30 .1 . 1 |

Hinzufiigen |

Installierte Gateways:

1723011

Entfernen |

ak. I Abbrechen

Zu Punkt 7 b): Tragen Sie im Feld 'Gateway’ die IP-Adresse der

zweiten (LAN-) Netzwerkkarte lhres Linux-Servers ein

 DNS = Domain Name Service. Wird im nachsten Kapitel besprochen.

folgende Parameter ein:
a) Auf der Seite IP-Adresse:
-Klicken Sie IP-Adresse festlegen
— Tragen Sie ins Feld IP-Adresse eine bis-
her ungenutzte IP-Adresse derselben
Netzwerknummer ein, die die zweite Netz-
werkkarte lhres Linux-Servers bedient.
Beispiel:
Ihr Linux-Server verwendet die IP-
Adresse/Subnet-Mask 172.30.1.1 /
255.255.255.0.
Dann verwenden Sie fir die Workstation:
172.30.1.11/ 255.255.255.0.
b) Auf der Seite Gateway:
- Tragen Sie ins Feld Neuer Gateway die IP-
Adresse der zweiten Netzwerkkarte Ihres
Linux-Servers ein, also z.B. 172.30.1.1.
— Klicken Sie auf Hinzufligen . Die IP-Adresse
muf nun im Feld Installierte Gateways er-
scheinen.
c) Auf der Seite DNS-Konfiguration®:
- Klicken Sie DNS aktivieren.

— Tragen Sie ins Feld Host ein: ws01.

— Tragen Sie ins Feld Doméane ein:
schuleX.alf.es.bw.schule.de
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Eigenzchaften fur TCP/IP
Gateway I WM S-Eonfiguration | |IP-&dresse
Bindungen I E nwesitert DS -Kanfiguration

" DMS deaktivieren

o

Host: stD'I Damane; Ischule'l e b s

Suchreihenfolge fur DHS-Server

134.108.233.211

Entfernen |

Suchreihenfolge fur Domanensuffis
Hinzufiigen |
Entfernen |

QK. I Abbrechen

UBUNG 6-1

— Tragen Sie ins Feld Suchreihenfol-
ge fir DNS-Server die IP-Adresse der
ersten Netzwerkkarte Ihres Linux-
Servers ein (der Karte, die mit dem
Internet / Cisco-Router verbunden ist),
also z.B. 134.108.233.211.

— Klicken Sie Hinzufligen . Die IP-
Adresse mufd nun im darunterliegen-
den Feld erscheinen.

— Klicken Sie OK und im Menl Konfi-
guration ebenfalls OK. lhre Einstellun-
gen sind nun gespeichert und werden
beim nachsten Start von Windows 95
aktiv.

8. Verbinden Sie Ihre Arbeitsstation tiber das Cross-Patchkabel™, das lhnen Ihr Dozent zur Verfligung
gestellt hat, mit lhrem Linux-Server.

9. Starten Sie lhre Arbeitsstation neu.

10. Testen Sie nach dem Neustart die Konfiguration, indem Sie verschiedenen Rechnern eine 'Antwort-
Aufforderung' senden (Ping-Kommando):

- Starten Sie eine MS-DOS-Eingabeaufforderung tber Start - Programme - MS-DOS-
Eingabeaufforderung.

— Geben Sie als Zielrechner fiir Ihre Antwortaufforderung verschiedene IP-Adressen an:

a) Beginnen Sie mit der lokalen Seite lhres Linux-Servers. Wenn die zweite Karte z.B. die IP-Adresse
172.30.1.1 verwendet, geben Sie ein:

ping 172.30.1.1 [C]

10 Bej Twisted-Pair-Verkabelung (10 Base-T) kénnen Gerate nie direkt verbunden werden, sondern stets tiber aktive Komponenten
(Hub etc.). Will man trotzdem eine direkte Verbindung realisieren, muf? das Verbindungskabel "gedreht" sein, d.h. alle Anschlusse
sind gegeniber normalen Kabeln vertauscht.
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Wenn der Linux-Server antwortet, erhalten Sie in etwa folgende Ausgabe:
Reply from 172.30.1.1: bytes=32 tinme=1ns TTL=64
Reply from 172.30.1.1: bytes=32 tine<l10ms TTL=64

Reply from 172.30.1.1: bytes=32 tinme<l0Ons TTL=64
Reply from 172.30.1.1: bytes=32 tine=1ns TTL=64

b) Verwenden Sie als zweites Ziel die erste Karte lhres Linux-Servers, welche mit dem Internet ver-
bunden ist. Wenn diese z.B. die IP-Adresse 134.108.233.211 besitzt, geben Sie ein

ping 134.108.233.211 [O].

¢) Wahlen Sie nun Rechner im Internet. Geben Sie z.B. ein:

ping 129.143.2.4 [O] (Belwi)
ping 195.122.135.172 [O] (Server der Firma Vivex GmbH in Berlin)

Wenn Sie von allen Rechnern Antwort erhalten, ist Ihre TCP/IP-Konfiguration korrekt.
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Ubung 6-2
Installation des Netscape Communicators

In dieser Ubung werden Sie das Programmpaket "Netscape Communicator" installieren und fiir die Ver-

wendung eines Proxy-Servers konfigurieren.

Vorgehensweise: Sie installieren auf lhrer Workstation den Netscape Communicator.
Folgen Sie den nachfolgenden Anweisungen. Ihr Dozent wird Ihnen weitere Informa-
tionen geben, die die spezielle Konfiguration des Kursraumes betreffen.

Voraussetzungen: - fur die 32bit-Version eine Workstation mit Windows 95
- fur die 16bit-Version eine Workstation mit Windows 3.1x
- die gewiinschte Installationsdatei:
CC32E404.EXE (Communicator 32bit) bzw. CC16E404.EXE (Communicator 16bit)

Fragen Sie Ihren Dozenten nach dem Pfad zur betreffenden Netscape-Installationsdatei:

[ =T

Wenn Sie Windows 3.1x verwenden, flihren Sie folgende Schritte aus:

1. Verbinden Sie ein Netzlaufwerk, z.B. N:\, mit dem Verzeichnis auf dem Installations-Server, in dem

sich die Netscape-Installationsdatei befindet.
2. Wabhlen Sie Datei.
3. Wabhlen Sie Ausfiuihren .
4. Geben Sie ein N:\ [O].
5. Doppelklicken Sie CC16E404.EXE und klicken Sie OK.

Klicken Sie NEXT und folgen Sie den Anweisungen @) - s) der Installation unter Windows 95 (nachfol-

o
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Wenn Sie Windows 95 verwenden, flihren Sie folgende Schritte aus:
a) Verbinden Sie ein Netzlaufwerk, z.B. N:\, mit dem Verzeichnis auf dem Installations-Server, in dem
sich die Netscape-Installationsdatei befindet.

b) Wahlen Sie Start.

c) Wahlen Sie Ausfihren

d) Geben Sie ein N:\ [O].

e) Doppelklicken Sie CC32E404.EXE und klicken Sie OK.

f) Klicken Sie NEXT.

g) Akzeptieren Sie die Lizenzvereinbarung. Klicken Sie Yes.
h) Wahlen Sie den 'Setup Type' typical. Klicken Sie Next.
i) Akzeptieren Sie das Anlegen eines neuen Verzeichnisses. Klicken Sie Ja.

j) Akzeptieren Sie das Anlegen einer neuen Programmgruppe. Klicken Sie Next.
k) Lesen Sie die Auflistung lhrer gewahlten Optionen. Klicken Sie Install.
m) Lehnen Sie das Lesen der README-Datei ab. Klicken Sie Nein.
n) Wenn die Installation abgeschlossen ist, bestatigen Sie die Meldung 'Setup is complete’ mit OK
0) Starten Sie den Netscape Communicator (Navigator).
p) Klicken Sie auf der Seite 'Creating a new profile' auf Weiter

g) Lassen Sie alle Felder leer. Klicken Sie Weiter.

r) Akzeptieren Sie alle Vorgaben. Klicken Sie Fertigstellen.
s) Wahlen Sie den Netscape Navigator als lhren 'Default Browser'. Klicken Sie Yes.

8. Geben Sie die IP-Adresse lhres Linux-Servers in das Feld Location ein.
Beispiel: Sie geben ein: http://134.108.233.211 [[].
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Ersetzen Sie jedoch obige IP-Adresse durch diejenige lhres Linux-Servers.

Schauen Sie sich die Informationen auf der Standard-Homepage dieses Servers an.

Wenn Sie bisher alle Komponenten (Routing, IP-Masquerading, DNS-Cache-Server) korrekt konfigu-

riert haben, haben Sie jetzt schon einen vollwertigen Internet-Zugang realisiert. Wenn noch kein DNS-
Server installiert ist, geben Sie bitte nur die IP-Adressen der Webserver ein. Testen Sie durch Einga-

be verschiedener URLs im Feld Location, z.B.:

http://www.belwue.de (IP-Adresse:  http://129.143.2.13)
http://www.ibm.de (IP-Adresse:  http://192.109.81.2)
http://www.yahoo.de (IP-Adresse:  http://195.67.49.46)

Wenn Ihr Internet-Zugang tiber einen Proxy-Server realisiert ist (s. Ubung 8-1), so miissen Sie des-
sen IP-Adresse im Netscape-Browser eintragen. Andernfalls ist kein Zugriff aufs Internet moglich.

a) Klicken Sie Edit.

b) Klicken Sie Preferences...

c) Doppelklicken Sie Advanced.

d) Klicken Sie Proxies.

e) Wahlen Sie Manual Proxy Configuration.
f) Klicken Sie View...

g) Geben Sie in den Feldern HTTP und FTP die IP-Adresse des Proxy Servers ein und die verwen-
deten Port-Nummern. Erfragen Sie diese ggf. vom Dozenten.

[ LIt 0T A L0 1 0 = N

FTP: IP-AdreSSE GBS PrOXY-SEIVEIS: .. .eiiiiiiiteeiitie e ettt ettt e ettt e e ettt e e et e e e s abb e e e e asbe e e e aatbe e e s abreeeeeennee

h) Klicken Sie OK.

i) Netscape verwendet zusatzlich zu eventuell eingetragenen Proxy-Servern einen eigenen Zwi-
schenspeicher (Cache) auf der lokalen Festplatte der Workstation. Dies ist meistens tberflissig und
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kann deaktiviert werden. Klicken Sie hierfiir im Meni Preferences->Advanced auf Cache. Tragen
Sie in die Felder Memory Cache und Disk Cache jeweils 0O ein. Da die Zwischenspeicher bereits teil-
weise aufgefillt wurden, leeren Sie sie durch Klicken auf Clear Memory Cache und Clear Disk
Cache.

j) Klicken Sie zum Speichern der Konfiguration auf OK.

Preferences E2 |

LCategon:

B- Appearance Configure proxies to access the Intemet
i -Fonts

i b Colors
E| I avigatar A retwork, prosy iz uged to provide additional security between pour
- computer and the Internet [usually along with a firewall] andor to
increaze performance bebween nebwaorks by reducing redundant traffic

i Languages
- Bypplications

H . wvia caching.
B Mail & Groups
-- Composer " Direct connection to the Intemet
" Offline £ Manual prosy configuration Wiew... |
= .-’-'«_dvanu:ed
i Cache " Automatic prosy configuration

Canfiquration lacation [URL): I
i Digk Space

Reload |

Manual Proxy Configuration
r Servers
Type Address of prosy server bo use Port
HTTP: 1723011 s
Secury:  [172.30.1.1 3128
FTF; |1?2.3|11.1 :|3128
Socks:  [172301.1 3128
Gopher: |1 72.30.1.1 : |31 28
WIS |1?2.3|11.1 :|3128
r Exceptionz
Do not use prowy zervers for domaing beginning with:
F
-
Uze commas [,) to zeparate entries.
(] I Cancel |

Zu Punkt (11): Tragen Sie bei Verwendung eines Proxy-Servers die erforderlichen Parameter unter Manual

Proxy Configuration = View ein.
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Ubung 7-1
Einrichten eines DNS-Cache-Servers

In dieser Ubung werden Sie auf Inrem Linux-Server einen DNS-Cache-Server einrichten.

Vorgehensweise: Sie richten auf lnrem Linux-Server einen DNS-Cache-Server ein.

Folgen Sie den nachfolgenden Anweisungen. Ihr Dozent wird Ihnen weitere Informa-
tionen geben, die die spezielle Konfiguration des Kursraumes betreffen.

Voraussetzungen: - das Paket bind aus der Paketserie n muf} installiert sein (bei der installierten Kon-

figuration Internet access server bereits enthalten)

Melden Sie sich als Benutzer root an Ihrem Linux-Server an und starten Sie Xwindows mit startx [].
Starten Sie den Editor Xcoral und 6ffnen Sie Uber File > Read file die Datei/ et c/rc. confi g.

Suchen Sie iiber Search - Forward search nach der Zeichenkette START _NAMED. Andern Sie die

gefundene Zeile in
START_NAMED=yes

Suchen Sie Uber Search - Forward search nach der Zeichenkette SEARCHLI ST= .Tragen Sie zwi-
schen die Hochkommas lhren Doméanennamen ein, z.B.: schulel.alf.es.bw.schule.de. Der Abschnitt
sieht dann in etwa wie folgt aus:

domai n searchlist that should be used in /etc/resolv. conf
(e.g. "suse.de linux.de uni-stuttgart.de")
Attention! this has to be filled out, if you want to access a nane

server

H OHF OH OH OH H

SEARCHLI ST="schul el. al f. es. bw. schul e. de"
#

Unmittelbar im Anschlufd an obigen Abschnitt finden Sie den Eintrag NAVESERVER=. Tragen Sie dort
die IP-Adresse lhres Linux-Servers ein, von dem die Informationen zur Namensauflésung bezogen
werden sollen. Geben Sie einfach die stets gltige IP-Adresse 127.0.0.1 fur den localhost an. Der zu-
gehorige Abschnitt sieht dann wie folgt aus:
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space separated |ist of nameservers that should be used for
/etc/resol v. conf

give a maxi mum of 3 | P nunbers

(e.g. "192.168.116.11 192.168.7.7")

H OH OH HF OH FH

NAMESERVER="127. 0. 0. 1"
#

Speichern Sie die Datei/ et c/ rc. confi g Uber File > Save file.
Offnen Sie tiber File - Read file die Datei / et ¢/ naned. boot .
Uberpriifen Sie, ob die Kommentarzeichen ' ; ' vor den folgenden beiden Zeilen entfernt sind:

directory /var/ named
cache . root.cache

Entfernen Sie in der Zeile f or war der s das Kommentarzeichen ' ;' und tragen Sie die IP-Adresse
des Nameservers lhres Providers ein (fur BelWu: 129.143.2.4). Beispiel:

forwarders 129.143.2.4

Uberprifen Sie, ob in der letzten Zeile der Eintrag s| ave vorhanden ist. Falls nicht bzw. falls die Zeile
mit einem Kommentarzeichen beginnt, tragen Sie die Zeile s| ave ans Ende der Datei ein.

Speichern Sie die Datei / et ¢/ named. boot Uber File > Save file. Beenden Sie Xcoral.
Aktualisieren Sie Ihre Konfiguration durch Eingabe von SuSEconfig [O].

Starten Sie den Namens-Damonen durch Eingabe von named [O].

Offnen Sie ein weiteres Xterminal und geben Sie ein: tail —f /var/log/messages [ .

Hierdurch kénnen Sie aktuelle Systemmeldungen, die der sysl ogd in die Datei
/var /1 og/ messages schreibt, mitlesen.

Bei erfolgreichem Start des named erhalten Sie in etwa folgende Meldung:
Jun 22 15:30: 55 server naned[639]: starting

Jun 22 15:30:56 server naned[ 639]: cache zone "" | oaded (serial 0)
Jun 22 15:30: 56 server naned[ 640]: Ready to answer queries.
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Testen Sie die Konfiguration. Geben Sie ein: nslookup [O].

— Geben Sie beliebige Rechnernamen ein, z.B.:

> www.vivex.de []
>noc2.belwue.de []

Bei korrekter Konfiguration erhalten Sie die zugehorige IP-Adresse.

— Geben Sie beliebige IP-Adressen ein, z.B.:

> 204.71.200.69 [[]
> 134.108.233.130 [C]

Bei korrekter Konfiguration erhalten Sie die zugehérigen Namen.

Beenden Sie nslookup mit [Strg]+[C].

Testen Sie die Konfiguration auf Ihrer Windows 95-Workstation. Starten Sie Gber Start > Program-

me > MS-DOS-Eingabeaufforderung eine MS-DOS-Eingabeaufforderung.

Geben Sie ein:

ping www.vivex.de [(]
ping noc2.belwue.de [O]

Sie erhalten bei korrekter Konfiguration die zugehérige IP-Adresse und die Dauer in ms bis zur Rick-
sendung des Paketes.

Uberzeugen Sie sich, daR sich obige Informationen im Cache befinden. Ziehen Sie an lhrem Linux-
Server das Netzwerkkabel, welches mit dem Internet (bzw. Hausnetz) verbunden ist, und wiederholen
Sie Punkt 14.

Nun wird nur noch der Name aufgeldst, wahrend fur die Paketlbermittlung ein timeout eintritt.

Stecken Sie anschlieRend das Netzkabel wieder in den Linux-Server!

. Starten Sie auf Ihrer Workstation den Netscape Navigator. Sie kdnnen nun ‘ganz normal’ surfen.

[]
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Ubung 8-1
Grundkonfiguration des Proxys squid

In dieser Ubung werden Sie auf Ihrem Linux-Server den Proxy squid konfigurieren.

Vorgehensweise: Sie konfigurieren auf Ihrem Linux-Server den Proxy squid.
Folgen Sie den nachfolgenden Anweisungen. Ihr Dozent wird Ihnen weitere Informa-
tionen geben, die die spezielle Konfiguration des Kursraumes betreffen.

Voraussetzungen: - das Paket squid aus der Paketserie n mul} installiert sein (bei der installierten
Konfiguration Internet access server bereits enthalten)

1. Melden Sie sich an lhrem Linux-Server als root an und starten Sie Xwindows Uber startx [O].

2. Uberpriifen Sie, ob squid bei jedem Systemstart automatisch gestartet wird. Dies geschieht tiber ei-
nen entsprechenden Eintrag in der Datei/ et c/rc. confi g.

-Starten Sie den Editor Xcoral und laden Sie die Datei/ et ¢/ rc. conf i g Uber File > Read file.

— Suchen Sie Uber Search - Forward search nach dem Eintrag START_SQUI D. Der korrekte Ein-
trag muf3 wie folgt lauten:

#

# Start the squid WWVproxy ? (yes/no)
#

START_SQUI D=yes

#

Andern Sie den Eintrag, falls START _SQUI D=no eingetragen ist.
— Speichern Sie die Datei / et ¢/ r c. confi g Uber File > Save file.

3. Laden Sie mit dem Editor Xcoral tber File - read file die Datei squid-Konfigurationsdatei
/et ¢/ squi d. conf .

4. Suchen Sie Uber Search - forward search den Eintrag ht t p_port und notieren Sie ihn:
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Diese Portnummer miissen Sie im Netscape-Navigator auf Ihren Client-PC's eintragen, wenn diese
den Proxy verwenden sollen. Der Standard-Eintrag ist:

# TAG http_port

# The port number where squid will listen for HTTP client

# requests. Default is 3128, for httpd-accel npde use port 80.
# May be overridden with -a on the comand |i ne.

#

http_port 3128

Suchen Sie Uber Search - Forward search nach dem Eintrag cache_ngr . Hier kénnen Sie die
Emailadresse des Verantwortlichen fir den Proxy eintragen. Diese erscheint dann z.B. in Meldungen,
die vom Proxy generiert werden. Wenn Sie auf lhrem Linux-Server einen Benutzer webmaster ange-
legt haben, dann kdnnte der Eintrag wie folgt aussehen:

# TAG cache_nygr

# Emai | - address of |ocal cache manager who will receive
# mail if the cache dies. The default is "webnmaster."
#

cache_nmgr webmaster @chul el. al f. es. bw. schul e. de

Da es auf lhrem System (noch?) keinen Webmaster gibt, tragen Sie ein:

cache_mgr root @chul el. al f. es. bw. schul e. de

Direkt darunter finden Sie die Benutzerkennung, unter der squid lauft. Der Eintrag mul3 wie folgt lau-
ten:

# TAG cache_effective_user

# If the cache is run as root, it will change its effective/real
# UDGADto the UDAD specified below The default is not to
# change U D/ d D.

#

cache_effective_user squid nogroup

Suchen Sie Uber Search - Backward search nach dem Eintrag LOGFI LE. Im gefundenen Ab-
schnitt LOGFI LE PATHNAMES AND CACHE DI RECTORI ES wird definiert, welches Verzeichnis fur
den Cache verwendet wird und wo sich die Logdateien befinden. Schauen Sie sich die Einstellungen
an, ohne Sie zu verandern.

VergréRern Sie den verfligbaren Cache im RAM von 8 auf 16 MB. Suchen Sie den Eintrag
cache_nem entfernen Sie das Kommentarzeichen # und ersetzen Sie die '8' durch '16'. Der Eintrag
sieht dann wie folgt aus:
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TAG cache_nem (negabyt es)

[...]
The default is 8 Megabytes.

H OH OH H OH*

cache_mem 16

VergroRRern Sie den Speicherbereich, der dem Proxy auf der Festplatte zur Verfligung steht. Wahlen
Sie an lhrer Schule mdglichst 200 — 300 MB. Hier stellen Sie bitte 200 MB ein. Suchen Sie den Ein-

trag cache_swap, entfernen Sie das Kommentarzeichen # und ersetzen Sie die 100 durch 200. Der
Eintrag sieht dann wie folgt aus:

# TAG cache_swap (megabytes)

# [...]

#

cache_swap 200

Speichern Sie die Datei / et ¢/ squi d. conf Uber File > Save file und beenden Sie den Editor
Xcoral.

Starten Sie den squid neu, so daR alle Anderungen aktiv werden:

- Bestimmen Sie die Proze3-Nr. des squid. Geben Sie ein:

ps ax | grep squid [O]

Die Nummer vor der Meldung / usr/ shi n/ squid —sYD st die gesuchte Prozel3-ID (PID).

— Alternativ: Die PID steht ebenfalls in der Datei / var / squi d/ | ogs/ squi d. pi d. Uberzeugen Sie
sich durch Eingabe von

more /var/squid/logs/squid.pid []

- Starten Sie nun squid neu. Geben Sie ein:

kil -1 PID (die Nummer, die Sie eben bestimmt haben)

Ihr Proxy ist nun auf dem Linux-Server betriebsbereit. Sie kbnnen squid manuell stoppen/starten tber

/sbin/init.d/squid stop [(] bzw. /sbin/init.d/squid start [[J]



U 38 Usuna 8-1

Multimedi@®
Schule

Proxy-Eintrag im Netscape Communicator

13.

14.

15.

Damit lhre Clients den Proxy verwenden kdnnen, mussen Sie ihn im Netscape Communicator eintra-
gen. Die Beschreibung finden Sie in Ubung 6-2, Punkt 11 .

Achtung: Der Proxy squid verwendet die Port-Nummer 3128! Tragen Sie diese Portnummer und die
IP-Adresse der zweiten Netzwerkkarte (die mit dem LAN verbunden ist) im Netscape Communicator

auf Ihrer Workstation ein.

Wenn Sie beobachten wollen, was Ihr Proxy in seinen Cache einlagert, geben Sie auf lhrem Linux-

Server folgendes Kommando ein:

tail —f /var/squid/logs/store.log [ O]

Wenn Sie beobachten wollen, wer auf den Proxy zugreift, geben Sie ein:

tail —f /var/squid/logs/access.log[ O]

Rufen Sie nun auf Ihrer Workstation verschiedene Webseiten auf. Beobachten Sie dabei auf dem
Server die Veranderungen der Logdatei st or e. | 0g.

Wenn Sie in lhnrem Browser die '‘Back'-Taste anklicken, erfolgt der Seitenaufbau deutlich schneller als
bei neu zu ladenden Webseiten; hier wird nun lhr Proxy aktiv.

[]
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Definition von Zugangsregeln auf dem Proxy

In dieser Ubung werden Sie auf lhrem Linux-Server Zugangregeln fir den Proxy squid definieren und
anschlieend testen.

Vorgehensweise:

Sie definieren auf Ihrem Linux-Server Zugangsregeln fir den Proxy squid.

Folgen Sie den nachfolgenden Anweisungen. Ihr Dozent wird Ihnen weitere Informa-
tionen geben, die die spezielle Konfiguration des Kursraumes betreffen.

Voraussetzungen: - installierter und konfigurierter Proxy squid (bei der installierten Konfiguration Inter-
net access server bereits enthalten und funktionsféhig)

— Proxy-Eintrag im Internet-Browser (Netscape Communicator) auf der Workstation

Folgende Regeln werden in dieser Ubung aufgestellt.

wenden dirfen.

a) Niemand soll auf URLs zugreifen kdnnen, in denen das Wort 'Sex' vorkommt.
b) Die Arbeitsstationen mit den IP-Adressen 172.30.1.5 bis 172.30.1.99 sollen das ftp-protokoll nicht ver-

1.

Melden Sie sich an lhrem Linux-Server als root an und starten Sie Xwindows uber startx [[].
2. Starten Sie den Editor Xcoral.

3. Laden Sie die Datei/ et ¢/ squi d. conf .

4. Suchen Sie den Abschnitt, der mit der Zeile
acl manager proto cache_object

beginnt. Fligen Sie vor der Zeile
# Al'l owi ng or

Denyi ng acces based on defined access lists
folgende Zeilen ein:
acl

sex url _regex sex Sex SEX
acl

no ftp proto FTP
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acl no_ftp_ips src 172.30.1.5-172.30.1.99/255. 255. 255. 255

Zeile 1 definiert die ACL 'sex’, die nach der Zeichenkette 'sex’ in beliebiger Schreibweise sucht.
Zeile 2 definiert die ACL 'no_ftp’, die nach der Verwendung des ftp-Protokolls sucht.

Zeile 3 definiert die ACL 'no_ftp_ips’, die nach anfragenden Rechnern mit IP-Adressen zwischen
172.30.1.5 und 172.30.1.99 / Netzmaske 255.255.255.255 sucht.

Der Abschnitt sieht dann wie folgt aus:

acl manager proto cache_obj ect

acl local host src 127.0.0. 1/255. 255. 255. 255

acl all src 0.0.0.0/0.0.0.0

acl SSL _ports port 443 563

acl Dangerous_ports port 7 9 19

acl CONNECT net hod CONNECT

acl sex url _regex sex Sex SEX

acl no ftp proto FTP

acl no_ftp_ips src 172.30.1.5-172.30. 1.99/255. 255. 255. 255

# Al l owi ng or Denying access based on defined access lists

5. Regeln Sie nun den Zugriff fur Ihre oben definierten ACLs. Fligen Sie folgende zwei Zeilen vor der
Zeile

# Al l ow everything el se

ein'":
http_access deny sex
http_access deny no_ftp no_ftp_ips

In der ersten Zeile wird der Zugriff abgelehnt, wenn die Bedingungen der ACL 'sex’ zutreffen.

In der zweiten Zeile wird der Zugriff abgelehnt, wenn die Bedingungen der ACL 'no_ftp' und
'no_ftp_ips' zutreffen (logische UND-Verkniipfung). Das bedeutet, dal3 gleichzeitig eine ftp-Anfrage
vorliegt und diese von einer Station mit einer IP-Adresse stammt, die in 'no_ftp_ips' definiert ist.

Der Abschnitt sieht dann wie folgt aus:
http_access deny manager !l ocal host

http_access deny CONNECT ! SSL_ports
http_access deny Dangerous_ports

" Dje Reihenfolge der Eintrage ist sehr wichtig. Es macht keinen Sinn, zunachst alles zu erlauben und anschlieRend Verbote
auszusprechen. Beginnen Sie stets mit individuellen Verboten, dann mit individuellen Erlaubnissen und beenden Sie den Abschnitt
mit der default-Regel htt p_access al |l ow al | bzw. http_access deny all.
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http_access deny sex
http_access deny noftp no_ftp_ips

# Al l ow everything el se

http_access allow all

6. Speichern Sie Datei/ et ¢/ squi d. conf Uber File > Save file und beenden Sie Xcoral.

7. Starten Sie den squid neu, so daf3 alle Anderungen aktiv werden:

- Bestimmen Sie die Prozel3-Nr. des squid. Geben Sie ein:

ps ax | grep squid [O]

Die Nummer vor der Meldung / usr/ sbi n/ squid —sYD st die gesuchte Prozel3-ID (PID).

- Starten Sie nun squid neu. Geben Sie ein:

kill =1 PID (die Nummer, die Sie eben bestimmt haben)

8. Testen Sie nun Ihre Regeln. Beobachten Sie die Veranderungen der Logdatei
/var/squi d/ | ogs/ access. | og durch Eingabe von:

tail —f /var/squid/logs/access.log[ [

Starten Sie auf Ihrer Windows 95-Arbeitsstation den Netscape Communicator und geben Sie ins Feld

Location ein:

www.novell.de (Zugriff erlaubt)
www.sex.de (Zugriff verboten)
server.alf.es.bw.schule.de (Zugriff erlaubt)
ftp://server.alf.es.bw.schule.de (Zugriff verboten)

Beobachten Sie dabei stets die Ausgabe des tail-FKommandos auf Ihrem Linux-Server. Achten Sie
insbesondere auf das Schliisselwort TCP_DENI ED fiur abgelehnte Anfragen.

9. Gestatten Sie anschlieend wieder ftp-Anfragen! Sie mussen dafir nur in der Datei
/ et ¢/ squi d/ conf das entsprechende Verbot mit einem # auskommentieren, so daf3 die Zeile wie

folgt aussieht:

# http_access deny no_ftp no ftp_ips
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Damit die Anderung wirksam wird, starten Sie den squid neu (siehe Punkt 7).

[]

10. Wenn noch Zeit verbleibt:. Stellen Sie weitere Regeln auf. Verwenden Sie dabei moglichst verschie-

dene ACL-Typen!



UBUNG 9-1 A U4

N
Multitmedi@
Schule

Ubung 9-1
Einrichtung des Firewalls

In dieser Ubung werden Sie auf Ihrem Linux-Server den Firewall einrichten und anschlieRend testen.

Vorgehensweise: Sie richten auf lhrem Linux-Server den Firewall ein.
Folgen Sie den nachfolgenden Anweisungen. Ihr Dozent wird Ihnen weitere Informa-
tionen geben, die die spezielle Konfiguration des Kursraumes betreffen.

Voraussetzungen: - installiertes Paket firewall aus der Serie n (in der installierten Konfiguration Internet
access server bereits enthalten)
— der Kernel mul3 firewalling unterstiitzen (ab SUSE Linux 5.2 ist dies der Standard)
- installierter und konfigurierter Proxy squid (in der installierten Konfiguration Internet
access server bereits enthalten und funktionsfahig)
— konfigurierte Dienste Domain Name Service (DNS) und IP-Masquerading

1. Melden Sie sich an lhrem Linux-Server als root an und starten Sie Xwindows Uber startx [[].

2. Starten Sie den Editor Xcoral.

3. Laden Sie die Datei/ et c/rc. confi g.

4. Suchen Sie den Abschnitt, der die Firewall-Variablen enthélt. Diese beginnen mit den Zeichen FW_

5. Andern Sie die Variable FW START auf den Wert yes:

FW START="yes"

6. Tragen Sie in die Variable FW LOCALNETS die Netzwerknummer Ihres zu schiitzenden LANs ein.
Wenn Sie flr Ihr internes Netz die Netzwerknummer 172.30.1.0 verwenden, so lautet der korrekte
Eintrag:

FW LOCALNETS="172. 30. 1. 0/ 255. 255. 255. 0"

7. Tragen Sie in die Variable FW WORLD_DEV die Netzwerkkarte ein, die mit dem Internet (bzw. dem
Cisco-Router) verbunden ist. Bei uns ist das et hO0.
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FW WORLD_DEV="et h0"

Tragen Sie in die Variable FW | NT_DEV die Netzwerkkarte ein, die mit dem lokalen Netz verbunden
ist. Bei uns ist das et h1.

FW_ | NT_DEV="et h1"
Damit Sie im Anschlul? Gberprifen kénnen, ob Ihr Firewall arbeitet, setzen Sie die Variable
FW LOG_ACCEPT auf yes. Hierdurch werden alle Datenpakete, die auf Firewall-Accept-Regeln pas-

sen (d.h. die erlaubterweise durch den Firewall gehen), in der Datei / var/ | og/ nessages mitge-
schrieben.

FW LOG_ACCEPT="yes"

Setzen Sie die Variable FW FRI ENDS auf yes. Nun kénnen Sie in der Datei / et ¢/ f wf ri ends
diejenigen Rechner angeben, die aus dem Internet uneingeschrankt auf Ihr lokales Netz zugreifen
durfen. Da diese Datei (noch) nicht vorhanden ist, darf dies niemand.

FW FRI ENDS="yes"

Setzen Sie die Variable FW | NOUT auf yes. Nun kénnen Sie in der Datei / et ¢/ f w- i nout diejeni-
gen Rechner angeben, die aus dem lokalen Netz direkt auf das Internet zugreifen durfen. Da diese
Datei (noch) nicht vorhanden ist, darf dies niemand.

FW I NOUT="yes"

Um alle Anfragen auf Standard-Ports ins Internet vom Firewall zu blockieren, achten Sie auf die ge-
sperrten Portnummern™? 1 bis 1023. Die Variablen FW TCP_LOCKED_PORTS und

FW UDP_LOCKED_PORTS sollten bereits wie folgt konfiguriert sein:

FW TCP_LOCKED_PORTS="1: 1023"
FW UDP_LOCKED PORTS="1: 1023"

Lassen Sie alle anderen Variablen unveréandert, speichern Sie die Datei/ et c/ rc. confi g Uber File
- Save file und beenden Sie Xcoral.

Aktualisieren Sie Ihr System durch Eingabe von
SuSEconfig [O].

Starten Sie Ihren Firewall durch Eingabe von

12 portnummern werden in der Datei / et ¢/ ser vi ces definiert.
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16. Lassen Sie sich die gegenwartige Konfiguration anzeigen durch Eingabe von

/sbin/init.d/firewall list [O].

von

17. Offnen Sie ein weiteres Xterminal und beobachten Sie die Verwendung lhres Firewalls durch Eingabe

tail —f /var/log/messages [ 0O].

Linux-Server. Geben Sie z.B. ein:

18. Starten Sie nun auf lhrer Windows 95-Workstation den Netscape Communicator. Geben Sie ins Feld
location verschiedene URLs ein und beobachten Sie die Ausgabe des tai-Kommandos auf dem

www.ibm.de

www.yahoo.de

www.alf.es.bw.schule.de

19. Beenden Sie das Protokollieren jedes Datenpaketes, indem Sie die Variable FW LOG_ACCEPT wieder
auf no zurlicksetzen:

Starten Sie auf dem Linux-Server Xcoral, laden Sie die Datei/ et ¢/ r c. confi g und &ndern die den
Wert fur FW LOG_ACCEPT auf no:

FW LOG_ACCEPT="no"

Speichern Sie die Datei/ et ¢/ rc. conf i g und starten Sie lhren Firewall neu durch Eingabe von
/sbin/init.d/firewall stop [O]

/sbin/init.d/firewall start [[]

Laden Sie die Datei / var / | og/ messages in den Editor Xcoral. L6schen Sie den gesamten Inhalt
der Datei und speichern Sie sie. Beenden Sie Xcoral.
20. Machen Sie voriibergehend lhr Netz "dicht". Geben Sie dafir ein:

/sbin/init.d/firewall block [O]

aufzurufen.

Versuchen Sie nun, mit dem Netscape Communicator auf lhrer Windows 95-Workstation Webseiten

Beenden Sie den Blockiermodus durch Eingabe von
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/sbin/init.d/firewall start [[]
21. Deaktivieren Sie im Netscape Navigator auf lhrer Windows 95-Arbeitsstation die Verwendung des
Proxys uUber Edit > Preferences ... > Advanced - Proxys - Direct connection to the internet

Versuchen Sie nun, Webseiten aufzurufen.

Ihr Firewall erzwingt die Verwendung des Proxys, um alle Verbindungen tiberwachen zu kénnen!
Aktivieren Sie wieder die Verwendung des Proxys uber Edit - Preferences ... > Advanced >

Proxys > Manual proxy configuration.
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Installation und Verwendung eines FTP-Clients

In dieser Ubung werden Sie einen FTP-Client installieren und fiir die Dateitibertragung zu lhrem Linux-
Server verwenden.

Vorgehensweise:

Sie installieren auf Ihrer Workstation den FTP-Client WS_FTP.

Folgen Sie den nachfolgenden Anweisungen. Ihr Dozent wird Ihnen weitere Informa-
tionen geben, die die spezielle Konfiguration des Kursraumes betreffen.
Voraussetzungen: - Windows 95 bzw. Windows 3.11
— die Installationsdatei WS_FTP32.ZIP
CA\TEMP.

1. Kopieren Sie die Datei WS_FTP32.ZIP in ein temporares Verzeichnis Ihrer Workstation, z.B.

2. Doppelklicken Sie die Datei WS_FTP32.ZIP. WinZip wird gestartet.
3. Kilicken Sie Actions

4. Wahlen Sie Extract...

5. Geben Sie im Feld Extract To: den Pfad zu Ihrem temporéaren Verzeichnis ein, z.B. CATEMP.
6. Klicken Sie Extract.

7. Beenden Sie WinZip.

8. Gehen Sie in Ihr temporéares Verzeichnis und doppelklicken Sie die Datei INST32.EXE.

9. Akzeptieren Sie die Lizenzbedingungen und klicken Sie Accept.

destination directory das Verzeichnis

10. Das Installations-Programm fragt in der Dialogbox Locate Directory nach dem Verzeichnis, in das
die Programm-Dateien von WS_FTP installiert werden sollen. Geben Sie ins Feld Please enter the

C:\PROGRAMM FILES\WS_FTP

an und klicken Sie OK.
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Anschlie3end fragt das Installations-Programm in der Dialogbox Locate Directory nach dem ge-
winschten Arbeitsverzeichnis:
Please enter your preferred local destination directory for the file transfers.

Geben Sie z.B. C:\Filetransfer ein und klicken Sie OK.

Nun werden Sie gefragt, welche Version von WS_FTP Sie installieren mdchten:

Please select the version or the versions to install. The recommended version for your system
is preselected.

Fir Windows 95 ist bereits die korrekte Checkbox aktiviert:

32 Bit 2 window version (Windows 95 or Windows NT only).

Klicken Sie anschlieRend OK.

Danach werden Sie nach dem Namen gefragt, unter dem WS_FTP im Programm-Manager von Win-
dows 95 eingetragen werden soll:

Please enter the name of the program manager group for WS_FTP:

Ubernehmen Sie den voreingestellten Namen WS_FTP. Klicken Sie OK.

Sie sollten nun eine Meldung bekommen, dal3 WS_FTP erfolgreich installiert wurde.
Starten Sie WS_FTP. Klicken Sie Start > Programme und anschlieRend den Eintrag, den Sie als

Menu-Eintrag fur die Programm-Manager-Gruppe eingegeben haben.
Hier befindet sich der Eintrag WS_FTP95LE, mit dem Sie WS_FTP starten kdnnen.

T ———— 1] 16. Melden Sie sich an lhrem
Linux-Server an. Verwenden
General I Startupl .-’-'l.d\-'ancedl Firewalll .
Sie folgende Parameter:
Frofile Mame; Iwebet j Mew
Hiost Mame/dddress: |1?'2.3EI.1.1 Delete | - Host-Name: IP-Adresse Ih-
Host Type: | Automatic detect =] res Servers (z.B. 172.30.1.1)
User 1D Iwebet ™ Anorymous — User ID: weber
Passuard: [ 7 Save Pud — Password: weber
— Account: weber
Account; I “““““
Comment: | Klicken Sie OK.
k. I Abbrechen [bernehmen Hilfe

Zu Punkt 16: Melden Sie sich an Ihrem Linux-Server an.

Die Funktionsweise des WS_FTP95LE ist ahnlich dem Windows Explorer. Auf der linken Seite finden
sie lhre eigene Verzeichnisstruktur, auf der rechten Seite die des ftp-Servers. Durch Anklicken einer
Datei wird der Upload- bzw. Download-Button ([ -] bzw. [ <] ) aktiv, je nach dem, ob die Datei zum —
oder vom ftp-Server Ubertragen werden soll. Klicken Sie den betreffenden Button und die Datei wird
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Achtung: Je nach vergebenen Rechten des angemeldeten Benutzers bzw. Dateirechten im Dateisy-
stem kann es vorkommen, dal’ Dateien nicht Gbertragen werden!

Ubertragen Sie einige Dateien zwischen lhrem lokalen Verzeichnis C: \ Tenp und dem Zielverzeichnis
/ t mp auf dem ftp-Server.

IT™wS_FTP95 LE 172.30.3.100 _ O] ]
—Local Spstem —Remaote System
lc:\temp j l/usr/local/httpd/htdcn:s j
” I Marme Date Size ChaDir ” | Mame Date Size | | ChaDir
(5] asblsp2.zip 980427 18:53 116 4 - 4+ . -
index. htm 970909 15:59 MkDir (1 gitf 980611 12:53 1024 MkDir
980520 13:34 (1 nanual 980611 14:32 1024
[% RP32_50.EXE 980526 14:54 14 (] =nv 980625 20:17 1024
960523 03:51 15 View ] doc 980611 14:32 12 View
(%] shockwawef las™~ 980519 09:56 1 <“| ] hilfe 980611 14:32 21
VIVOPLAY .EXE 980526 11:31 g Exrec support—db 980611 12:518 19 Exrec
. 980625 20:13 h o | index. html 980611 14:32 1116 h
ws_ftp32.zip 980611 16:53 g sname sname
Delete Delete
Refresh Refresh
LlLI Ditlnfo Ditlnfo
& ASCI " Binary
150 Opening ASCI mode data connection for Abindls. =
Received 623 bytes in 0.1 secs, [B0.00 Kbps), transfer succesded 1
22B Transfer complete. hd
LCloze | Cancel | Logtwind | Help | Options | About | Exit |

Zu Punkt 15: Ubertragen Sie einige Dateien zwischen Ihrem Verzeichnis C:\Temp und dem ftp-Server
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Ubung 11-1
Konfiguration des Apache-Webservers

In dieser Ubung werden Sie auf Inrem Linux-Server den Apache-Webserver konfigurieren.

Vorgehensweise: Sie konfigurieren auf Ihrem Linux-Server den Apache-Webserver.
Folgen Sie den nachfolgenden Anweisungen. Ihr Dozent wird Ihnen weitere Informa-
tionen geben, die die spezielle Konfiguration des Kursraumes betreffen.

Voraussetzungen: - installiertes Paket apache aus der Serie n (in der installierten Konfiguration Internet
access server bereits enthalten)

1. Melden Sie sich an lhrem Linux-Server als root an und starten Sie Xwindows Uber startx [[].

2. Starten Sie den Editor Xcoral.

3. Laden Sie die Datei/ et c/rc. confi g.

4. Suchen Sie die Variable START_HTTPD.

5. Uberpriifen Sie, ob die Variable START HTTPD auf den Wert yes gesetzt ist, holen Sie dies ggf.
nach:

START_HTTPD=yes

6. Laden Sie die Datei/ et ¢/ htt pd/ htt pd. conf.
Verhindern Sie, dal3 der Webserver versucht, die Namen von anfragenden Clients aufzulésen. Dies
fahrt bei lokalen Workstations zu extrem langen Wartezeiten, da inre Namen im DNS nicht bekannt
sind. Suchen Sie den zugehdrigen Parameter Host naneLookups und &ndern Sie dessen Wert auf
of f:

Host nameLookups of f

7. Tragen Sie ein, wem per Email Probleme mit dem Webserver mitgeteilt werden sollen. Suchen Sie
den Abschnitt # Server Adni n und andern sie den vorhandenen Eintrag in:



10.

11.

12.

UBUNG 11-1 A U5l

N
Multitmedi@
Schule

# Server Admi n: Your address, where problens with the server shoul d
# be e-muil ed.

Server Adm n root @chul el. al f. es. bw. schul e. de

Es ist sinnvoll, dal? der Webserver "seinen eigenen Namen kennt". Sie finden hierzu den Abschnitt
# Server Nanme. Tragen Sie dort den Namen lhres Servers ein,
z.B. server.schulel.alf.es.bw.schule.de:

ServerNanme all ows you to set a host name which is sent back to
clients for your server if it’'s different than the one the program
woul d get (i.e. use "ww' instead of the host’s real nane).

Not e: You cannot just invent host nanes and hope they work. The
name you define here nmust be a valid DNS nane for your host. I|f

H OHF OH OF OH K H

you don’t understand this, ask your network adm nistrator.

Server Nane server.schul el. al f.es. bw. schul e. de

Achtung: Wie bereits im Kommentar vermerkt, mufl3 hier der "echte” DNS-Name stehen (der Name,
unter dem lhr Server im Internet bekannt ist)!

Speichern Sie die Datei / et ¢/ ht t pd/ ht t pd. conf (ber File > Save file und beenden Sie Xcoral.
Damit Ihre Einstellungen wirksam werden, starten Sie den Webserver neu. Der ht t pd hat eine ganze
Reihe von Prozessen gestartet, von denen Sie nur dem sog. Parent-Prozel3 das Signal 1 senden. Die
zugehorige Prozel3-ID (PID) finden Sie in der Datei / var / run/ htt pd. pi d. Geben Sie ein:

cat /var/run/httpd.pid [O]

Senden Sie nun das Signal 1 an diesen Prozel3-ID:

kill =1 PID (die Nummer, die obiges Kommando ausgegeben hat)

Damit Ihre Schuler Homepages auf dem Webserver ablegen kdnnen, legen Sie ein zentrales Unter-
verzeichnis unter / usr/ 1 ocal / ht t pd an. Nennen Sie es snv (Schiler-Mitverantwortung). Dies ge-
schieht mit dem Kommando

mkdir /usr/local/httpd/htdocs/smv [[]

Damit jeder dort html-Dokumente ablegen kann, missen Sie noch die Zugriffsrechte andern. Geben
Sie ein:
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chmod ugo+rwx /usr/local/httpd/htdocs/smv [O]
Ihre Schiler kbnnen nun via FTP im Verzeichnis smv beliebige Webseiten ablegen.

13. Schauen Sie sich an, wer auf Inren Webserver zugreift. Alle Zugriffe werden in der Datei
/var/1og/ httpd. access_| og mitgeschrieben. Geben Sie ein:

tail —f /var/log/httpd.access_log[ 0]

Achtung: Nur "echte" Zugriffe werden protokolliert. Zugriffe auf Webseiten, die sich bereits im Proxy-
Cache befinden, kénnen naturlich nicht mitgeschrieben werden.

14. Richten Sie einen Benutzer smv ein, mit dem sich lhre Schiler am ftp-Server anmelden kénnen.
Starten Sie hierfur yast und wéahlen Sie Administration des Systems - Benutzerverwaltung.

Tragen Sie ins Feld Benutzername ein smv und driicken Sie sooft die Tabulatortaste, bis Sie ins Feld
PalRwort gelangen. Geben Sie ebenfalls smv ein und wiederholen Sie die Eingabe im nachsten Feld.

Dricken Sie abschliel3end [F4] und verlassen Sie yast durch wiederholtes Driicken der [Esc]-Taste.

15. Starten Sie auf lhrer Windows 95-Workstation den ftp-Client WS_FTP. Melden Sie sich an Ihrem
Server unter der soeben eingerichteten Benutzerkennung smv an.

16. Wenn Sie verbunden sind, wéhlen Sie im rechten Fenster (Server-Seite) das Verzeichnis
/usr/local / httpd/ htdocs/sm

Ubertragen Sie von lhrer Workstation aus einige html-Dokumente auf den Linux-Server. Ihr Trainer
stellt Ihnen gerne Webseiten zur Verfigung.

17. Starten Sie den Netscape Navigator. Geben Sie ins Feld location die IP-Adresse lhres Servers ein.
Stobern Sie ein wenig in der Apache-Dokumentation und im SuSE-Hilfesystem. Beobachten Sie dabei
die Ausgabe des tai-Kommandos auf dem Linux-Server!

18. Geben Sie im Netscape Navigator ins Feld location nun den Pfad zu lhren Webseiten ein, z.B.:

http://134.108. 233. 211/ smv//test. htm

19. Richten Sie nun eine "personliche" Webseite flir den Benutzer "weber" ein. Sie missen ihm hierflr
auf dem Linux-Server zunachst das Verzeichnis publ i c_ht ml in seinem Stammverzeichnis anle-

gen:

mkdir /nome/weber/public_html [O]
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20. Dieses Verzeichnis muf von jedem betreten und gelesen werden kénnen. Geben Sie ein:
chmod ugo+rx /home/weber/public_html []

21. Kopieren Sie eine Webseite in dieses Verzeichnis (z.B. mit ftp) und benennen Sie sie um in
i ndex. htm :

mv /home/weber/public_html/* /home/weber/public_html/index.html [O]
22. Wenn Sie nicht als "weber" angemeldet sind, machen Sie "weber" zum Eigentiimer seiner Startseite:
chown weber /home/weber/public_html/* [O]

23. Uberpriifen Sie erneut die Zugriffsrechte der Dateien in diesem Verzeichnis: user, group und others
bendtigen die Rechte rx:

Is —I /home/weber/public_html/* [ O]
24. Sie kénnen nun auf lhrer Windows 95-Arbeitsstation die Webseite aufrufen unter
http://172.30. 1. 1/ ~weber

Hinweise: Wenn Ihr Linux-Server im DNS bekannt ist (das wird an Ihrer Schule der Fall sein, in die-
sem Kurs jedoch nicht), kbnnen Sie natirlich auch den Server beim Namen nennen:

http://server/~weber

Unglucklicherweise versucht in diesem Kurs lhr Linux-Server beim ersten Zugriff auf den Webserver
ebenfalls, dessen Name herauszufinden, den er z.B. in der Datei / et ¢/ host s findet. Damit wird Ihre
Anfrage umgewandeltin ht t p: // server. schul eX al f. es. bw. schul e. de/ ~weber. Dieser
Name kann nicht aufgelost werden, da er dem Nameserver von BelW nicht bekannt ist; lhre Anfrage
kann damit nicht mehr befriedigt werden. Um es noch einmal zu wiederholen: Dieses Problem wird an
Ihrer Schule nicht auftauchen, da Ihr Linux-Server dem Nameserver von BelWi bekannt gemacht
wird.

25. Optional: Wenn noch Zeit verbleibt...

Erstellen Sie eigene Webseiten. Verwenden Sie hierflir den Netscape Composer, der im Netscape
Communicator enthalten ist. Ubertragen Sie diese Seiten via ftp auf lhren Linux-Server.
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Ubung 13-1
Konfiguration des Linux-Mailservers

In dieser Ubung werden Sie auf Ihnrem Linux-Server den Linux-Mailserver konfigurieren.

Vorgehensweise: Sie konfigurieren auf Ihrem Linux-Server den Linux-Mailserver.
Folgen Sie den nachfolgenden Anweisungen. Ihr Dozent wird Ihnen weitere Informa-
tionen geben, die die spezielle Konfiguration des Kursraumes betreffen.

Voraussetzungen: - installiertes Paket sendmail aus der Serie n (in der installierten Konfiguration Inter-
net access server bereits enthalten)

1. Melden Sie sich an lhrem Linux-Server als root an und starten Sie Xwindows Uber startx [O].
2. Starten Sie den Editor Xcoral.
3. Laden Sie die Datei/ et c/rc. confi g.

4. Um Email aus dem Internet empfangen zu kénnen, mufd der Mailer-Damon am SMTP-Port aktiv sein.
Suchen Sie die Variable SMIP und tberprifen Sie, ob sie auf den Wert " yes" gesetzt ist. Holen Sie

dies ggf. nach:
SMIP="yes"

5. Damit in Absenderadressen fir lhre Email nicht der Name lhres Mailservers erscheint
(root@server.schulel...), tragen Sie in die Variable FROM_HEADER nur Ihren Domé&nennamen ein.

Fir Schulel ware z.B. der korrekte Eintrag:
FROM HEADER="schul el. al f . es. bw. schul e. de"

6. Damit SuSEconf i g jede Anderung der Mailparameter in die sendmail-Konfigurationsdatei
/et c/sendmai | . cf Ubertragt, mul? der zugehorige Parameter auf yes stehen. Suchen Sie die Va-
riable SENDVAI L_TYPE und uberprufen Sie, ob sie auf den Wert " yes" gesetzt ist. Holen Sie dies
ggf. nach:

SENDMAI L_TYPE="yes"
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Alle nicht lokale Mail soll dem Mailserver des Providers (z.B. BelW) Ubergeben werden. Tragen Sie
in die Variable SENDVAI L_ SMARTHOST die IP-Adresse (oder den Namen) des Mailservers lhres Pro-
viders ein. In dieser Ubung verwenden Sie bitte nur die Dummy-Adresse 100.100.100.100.

SENDMAI L_SMARTHOST="100. 100. 100. 100"

Sendmail mufl? wissen, welche Email als lokal angesehen und lokal abgespeichert wird. Ergdnzen Sie
in der Variablen SENDVAI L_LOCALHOST — durch Leerzeichen getrennt - den vorhandenen Eintrag

| ocal host um den Namen lhres Mailservers und lhrer Domé&ne (und evtl. vorhandene Aliasnamen).
Fir Schulel wére der korrekte Eintrag:

SENDMVAI L_LOCALHOST="1 ocal host server.schul el. al f. es. bw. schul e. de schu-
| el.al f.es.bw schul e.de"

Achtung: Zwischen allen Eintragen befindet sich genau ein Leerzeichen und kein Zeilenumbruch, der
Zeilenumbruch im obigen Eintrag ist durch die geringe Spaltenbreite dieser Unterlage entstanden!

Speichern Sie die Datei/ et ¢/ rc. confi g und beenden Sie Xcoral.

Damit automatisch eine neue sendmail-Konfigurationsdatei / et c/ sendmai | . cf generiert wird,
mussen Sie nun SuSEconf i g aufrufen Geben Sie ein:

SuSEconfig [O]

Starten Sie lhren Linux-Server neu. Geben Sie ein:

reboot [[]

Nach dem Neustart ist Ihr Mailserver betriebsbereit.

Anlegen von Email-Accounts

Benutzer, die Ihren Linux-Server lediglich als Mailserver verwenden, benétigen kein Stammverzeichnis

und keine weiteren Rechte im Linux-System. Nur die Anderung des PaRworts sollte méglich sein. Dies

erreichen Sie wie folgt:

13.

Melden Sie sich als root an und starten Sie Xwindows.

14. Starten Sie Yast. Wéahlen Sie Administration des Systems - Gruppenverwaltung. Legen Sie eine

neue Gruppe emailusers an. Diese wird spater alle "Nur-Email"-Benutzer enthalten, die insbesondere
nicht Mitglied der Standardgruppe users werden.
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Geben Sie ins Feld Name der Gruppe ein:
emmi | user s und driicken Sie die Tabulatortaste.

15. Akzeptieren Sie die vorgeschlagene Numerische Gruppen-ID und driicken Sie die Tabulatortaste.
ein: emai | und driicken Sie die Tabulatortaste.

16. Geben Sie ins Feld PalRwort fur Zugriff auf Gruppe
17. Wiederholen Sie im Feld PalRwort wiederholen das PaRwort emai | und driicken Sie die Tabulator-

taste.
18. Schliel3en Sie das Anlegen der Gruppe emailusers ab durch Driicken von [F4].

19. Dricken Sie [Esc]. Sie gelangen ins vorherige Meni. Wahlen Sie nun Benutzerverwaltung.

20. Legen Sie die "Nur-Email"-Benutzer donald, daffy und daisy an.

a) Tragen Sie ins Feld Benutzername ein: donald und driicken Sie die Tabulatortaste.

b) Akzeptieren Sie die Numerische User-ID und driicken Sie die Tabulatortaste.

c) Dricken Sie im Feld Gruppe die [F3]-Taste, bewegen Sie sich mit der Cursortaste [|] auf den

Eintrag emailusers, driicken Sie [(] und anschlieRend die Tabulatortaste.
d) Da Donald kein Stammverzeichnis benétigt, geben Sie im Feld Home-Verzeichnis ein:

/ t np und driicken Sie die Tabulatortaste.
e) Geben Sie im Feld Login-Shell ein: / bi n/ passwd und dricken Sie die Tabulatortaste.

f) Driicken Sie zum Anlegen des Benutzers die [F4]-Taste. Bestétigen Sie die Frage Soll fir den Be-
mit < Ja >.

nutzer wirklich kein Passwort eingetragen werden?

g) Bestatigen Sie die nachfolgende Meldung Das Home-Verzeichnis [...] mit < Weiter >.
h) Wiederholen Sie die Schritte a) bis g) fur die Benutzer daffy und daisy.
i) Driicken Sie abschlieRend sooft [Esc], bis sich Yast beendet.

21. Testen Sie die neuen Accounts. Gehen Sie mit [Strg]+[Alt]+[F2] auf eine andere Konsole und mel-

den Sie sich als donald an.
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22. Geben Sie fur donald ein PaRwort ein, z.B. entenhausen. Wiederholen Sie das PalRwort. Sie werden
anschlief3end sofort wieder abgemeldet.

23. Schalten Sie mit [Alt]+[F7] wieder in Inr Xwindows-Fenster um.

[]
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Ubung 13-2
Konfiguration des Email-Clients Netscape Messenger

In dieser Ubung werden Sie auf lhrer Windows 95-Workstation den Email-Client Netscape Messenger13
konfigurieren und testen.

Vorgehensweise: Sie konfigurieren auf lhrer Windows 95-Workstation den Email-Client Netscape
Messenger, indem Sie fiir verschiedene Email-Benutzer Benutzerprofile anlegen.
Folgen Sie den nachfolgenden Anweisungen. Ihr Dozent wird Ihnen weitere Informa-
tionen geben, die die spezielle Konfiguration des Kursraumes betreffen.

Voraussetzungen: - installierter Netscape Communicator

1. Schliel3en Sie ggf. Netscape und starten Sie auf Ihrer Workstation den Netscape User Profile Mana-
ger Uber Start > Programme > Netscape Communicator - Utilities > User Profile Manager.

2. Klicken Sie im Feld Select a profile auf New.

3. Lesen Sie die nachfolgende Information und klicken Sie Weiter >.

4. Geben Sie ins Feld Full Name ein: Donald Duck und driicken Sie die Tabulatortaste.

5. Geben Sie ins Feld Email Address ein**: donald@server.schuleX.alf.es.bw.schule.de und driicken
Sie [O].

6. Geben Sie auf der nachfolgenden Seite ins Feld Profile name ein: donald und driicken Sie die Ta-
bulatortaste.

7. Im darunterliegenden Feld schlagt Netscape lhnen einen Pfad zu den benutzerspezifischen Daten
vor: C:\Programme\Netscape\Users\donald. Akzeptieren Sie diesen Pfad und driicken Sie [O].

8. Akzeptieren Sie auf der Seite Mail and Discussion Groups Setup die Eintrdge Your Name und
Email-Address. Tragen Sie ins Feld Outgoing mail [SMTP] server die (innere) IP-Adresse lhres

13 Dieser ist im Programmpaket Netscape Communicator enthalten.

14 Die Angabe des Wortes server ist in diesem Kurs nétig, da der von uns verwendete Nameserver (BelWii) Ihren neu eingerich-
teten Linux-Rechner bzw. Mailserver nicht kennt. An lhrer Schule kénnen Sie das Wort server weglassen, sobald Ihr Mailserver
beim BelWu eingetragen ist.
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Linux-Servers ein (z.B. 172.30.1.1). Klicken Sie anschlieRend Weiter >.

Geben Sie auf der nachfolgenden Seite ins Feld Mail server user name ein: donald und drticken Sie
die Tabulatortaste. Tragen Sie ins Feld Incoming Mail Server die (innere) IP-Adresse lhres Linux-
Servers ein (z.B. 172.30.1.1). Klicken Sie anschlieRend Weiter >.

Geben Sie auf der nachfolgenden Seite ins Feld News (NNTP) server die (innere) IP-Adresse |hres
Linux-Servers ein (z.B. 172.30.1.1). Klicken Sie anschliel3end Fertigstellen. Netscape startet nun mit
diesen Einstellungen.

Sie mussen fiir den Zugriff ins Internet noch Ihren Proxy angeben (siehe Ubung 6-2, Punkt 11).
Damit jede Email, die Sie erhalten, auch nach dem Lesen auf dem Linux-Server verbleibt, missen Sie
diese Option aktivieren. Offnen Sie dafiir das Menii Edit > Preferences = Mail&Groups, wahlen Sie
Mail Server und aktivieren Sie im Feld Mail Server Type das Késtchen Leave messages on server
after retrieval.

Klicken Sie im kleinen Netscape-Auswahlfenster auf Mailbox. Es startet der Netscape Email-Client
Messenger. Geben Sie das PaRwort fir Donald ein, das Sie in der letzten Ubung vergeben haben.
Der Client tberpruft daraufhin, ob neue Mail fir Sie vorliegt.

Klicken Sie New Msg und schreiben Sie eine Email an daisy:

a) Damit die Mail lokal zugestellt wird, geben Sie ins Feld To: ein: daisy.

b) Lassen Sie sich das Zustellen der Mail bestéatigen. Klicken Sie das Kndpfchen unterhalb der Biiro-
klammer (Message Sending Options) und aktivieren Sie das Feld Return Receipt.

¢) Schreiben Sie die Mail und klicken Sie abschlieend Send.

d) Klicken Sie Get Msg. Der Mailclient kontaktiert Ihren Mailserver und holt neue Email ab. Sie haben
eine Empfangsbestatigung fur die Email an daisy erhalten.

Legen Sie ein neues Benutzerprofil fir daisy an (siehe Schritt 1 — 11). Nun kdnnen Sie die Mail fur
daisy abholen und lesen.

Um beim Start von Netscape nicht jedesmal ein Benutzerprofil auswahlen zu missen, kbénnen Sie das
jeweilige Profil bereits im Aufruf von Netscape (Verkniipfung mit Netscape) mitgeben. Erzeugen Sie

z.B. eine Verkniupfung auf dem Desktop, die Netscape mit dem Profil "donald” startet:

a) Offnen Sie im Windows-Explorer das Verzeichnis
C. \ Pr ogr anmre\ Net scape\ Contruni cat or\ Pr ogr am

b) Klicken Sie mit der rechten Maustaste auf die Datei netscape.exe und wahlen Sie Kopieren.
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c) Offnen Sie mit dem Windows-Explorer das Verzeichnis C: \ W ndows\ Deskt op, klicken Sie mit

der rechten Maustaste in die rechte Fensterhalfte und wéahlen Sie Verknipfung einfiigen
und wéhlen Sie Um-

d) Klicken Sie mit der rechten Maustaste auf Verkniipfung mit netscape.exe

benennen. Geben Sie donalds Netscape ein.
e) Klicken Sie mit der rechten Maustaste auf donalds Netscape und wéhlen Sie Eigenschaften.

f) Ergénzen Sie auf der Seite Verknipfung im Feld Ziel den vorhandenen Eintrag um

—P"donald"”
Achten Sie dabei unbedingt auf die richtige Syntax! Zwischen netscape.exe und —P befindet sich

ein Leerzeichen, zwischen —P und "donald" nicht.
Klicken Sie o.k. Sie kdnnen nun durch Doppelklick auf donalds Netscape (auf dem Desktop) Net-

scape mit donalds Benutzerprofil starten.
g) Wenn Zeit verbleibt, legen Sie eine weitere Verknipfung auf dem Desktop flr daisy an.
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Ubung 14-1
Konfiguration des Newsservers INN

In dieser Ubung werden Sie auf Ihrem Linux-Server den News-Server INN konfigurieren.
Vorgehensweise:

Sie konfigurieren auf Ihrem Linux-Server den News-Server INN.

Folgen Sie den nachfolgenden Anweisungen. Ihr Dozent wird Ihnen weitere Informa-
tionen geben, die die spezielle Konfiguration des Kursraumes betreffen.

Voraussetzungen: - installiertes Paket inn aus der Serie n (in der installierten Konfiguration Internet
access server bereits enthalten)
1.

Melden Sie sich an lhrem Linux-Server als root an und starten Sie Xwindows uber startx [[].
2. Starten Sie den Editor Xcoral.

3. Laden Sie die Datei/ et c/rc. confi g.

4. Damit der Newsserver bei jedem Booten des Linux-Servers automtisch startet, muf3 die Variable
sie auf den Wert yes:

START_| NN auf den Wert yes gesetzt werden. Suchen Sie die Variable START _| NN und setzen Sie
START_I| NN=yes

5. Speichern Sie die Datei/ et ¢/ rc. confi g Uber File > Save File.

6. Laden Sie Uber File > Read file die INN-Konfigurationsdatei / var /| i b/ news/ i nn. conf .

7. Tragen Sie den Namen lhrer Schule in den Parameter or gani zat i on ein. Dieser wird beim Zugriff
von Clients auf den Newsserver im Feld Organization angezeigt:

or gani zati on: Test - Schul e Must er hausen

8. Speichern Sie die Datei/ var /| i b/ news/ i nn. conf Uber File > Save File.

9. Laden Sie Uber File > Read file die Konfigurationsdatei / var/ | i b/ news/ nnr p. access.
Diese Datei regelt den Zugriff auf Ihren Newsserver. Eintrage haben die Form
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<Rechner nane oder | P-Adresse>: <Art des Zugriffs>: <Benutzername, der vor
dem Posten von Artikeln anzugeben ist>:<Pafl3wort, das vor dem Posten von
Artikeln anzugeben ist>:<Newsgroups, die gelesen werden dirfen>

Erlauben Sie allen Clients in Ihrem LAN den Zugriff auf Ihren Newsserver. Gestatten Sie sowohl das
Lesen (Read), als auch das Schreiben (Post) von allen Artikeln ohne Zugriffskontrolle. Tragen Sie die
folgende Zeile, sofern noch nicht vorhanden, an das Ende der Datei ein.

*'Read Post:::*

(Wenn Sie einen eigenen Nameserver eingerichtet hatten, der auch die Namen Ihrer Clients kennt,
konnte obiger Eintrag genauer formuliert werden. Fur die Doméne schulel.alf.es.bw.schule.de wére
der entsprechende Eintrag

* schul el. al f. es. bw. schul e. de: Read Post:::* )

Speichern Sie die Datei / var/ | i b/ news/ nnr p. access uber File > Save File.

Legen Sie nun neue Newsgroups an. Verwenden Sie hierfir das Kommando
fusr/1ibl/news/bin/ctlinnd newgroup

Figen Sie die Newsgroups Schul e. Lehrer, Schul e. Schuel er und Schu-

l e. Unterricht sfaecher hinzu. (Tip: Sie missen nicht jedesmal das vollstindige Kommando

eingeben; verwenden Sie einfach die Cursortaste [t], um das letzte Kommando zu editieren.) Die zu-

gehorigen Kommandos lauten:
{usr/lib/news/bin/ctlinnd newgroup Schule.Lehrer [[]
/usr/lib/news/bin/ctlinnd newgroup Schule.Schueler [[]

lusr/lib/news/bin/ctlinnd newgroup Schule.Unterrichtsfaecher [[]

Sie erhalten fur jede erfolgreiche Aktion die Meldung OKk.

Achtung: Verwenden Sie keine Umlaute oder Sonderzeichen fir die Namen Ihrer Newsgroups, andern-
falls kénnen diese Gruppen nicht verwendet werden!

Alle zur Verfligung stehenden Newsgroups werden in der Datei / var /1 i b/ news/ act i ve aufge-
fuhrt. Dort finden Sie mindestens die System-Gruppen control, control . cancel undj unk.

Neueintrage haben die Form

Nanme 0000000000 0000000000 vy
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In den Zahlenfeldern werden spater die vorhandenen Artikel gezahlt.
12. Uberpriifen Sie, welche Newsgroups Ihr Newsserver bereitstellt. Geben Sie ein:
lusr/lib/news/bin/getlist —h localhost [ []
Alternativ kdnnten Sie naturlich auch die Datei / var /| i b/ news/ act i ve in einem Editor betrachten.
13. Laden Sie in Xcoral Uber File > Read file die Datei/ var /| i b/ news/ newsgr oups.

Hier kbnnen Sie unter den vorhandenen Eintragen contr ol und j unk eine Beschreibung der jewei-
ligen Newsgroups eintragen. Fir obiges Beispiel konnte dies sein:

Schul e. Lehrer Lob und Beschwerden uber Lehrer
Schule.Schueler Der neueste Klatsch und Tratsch
Schule.Unterrichtsfaecher Was sollte veraendert werden?
14. Speichern Sie die Datei /var/lib/news/ newsgr oups Uber File > Save File und beenden Sie
Xcoral.

15. Damit Ihre Anderungen giiltig werden, starten Sie den Linux-Server neu. Geben Sie ein:
reboot [O].

16. Nach dem Neustart ist Ihr Newsserver betriebsbereit.
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Ubung 14-2
Konfiguration des Newsclients Netscape Collabra

In dieser Ubung werden Sie auf Ihrer Windows 95-Workstation den Newsclient Netscape Collabra konfi-
gurieren und testen, indem Sie auf Ihren zuvor eingerichteten Newsserver zugreifen.

Vorgehensweise: Sie konfigurieren auf lhrer Windows 95-Workstation den Newsclient Netscape Colla-
bra. Dieser ist im Programmpaket Netscape Communicator, welches Sie bereits in-
stalliert haben, enthalten. Nach der Konfiguration nutzen Sie den Client, um auf lhren
Newsserver zuzugreifen.

Folgen Sie den nachfolgenden Anweisungen. Ihr Dozent wird Ihnen weitere Informa-
tionen geben, die die spezielle Konfiguration des Kursraumes betreffen.

Voraussetzungen: - installiertes Programmpaket Netscape Communicator

1. Starten Sie auf Ihrer Windows 95-Workstation den Newsclient tber Start > Programme -> Net-
scape Communicator - Netscape Collabra.

2. Doppelklicken Sie im Fenster Select a profile das Benutzerprofil donald. Sie diskutieren damit unter
donalds Kennung.

3. Uberzeugen Sie sich davon, daR Ihr Linux-Server als Newsserver eingetragen ist. Wahlen Sie Edit =
Preferences... und dann unter Mail & Groups den Eintrag Groups Server. Im Feld Discussion
groups (news) server muf die (innere) IP-Adresse lhres Servers™ (z.B. 172.30.1.1) eingetragen
sein. Klicken Sie anschliel3end OK.

4. lhr Newsserver bzw. dessen IP-Adresse ist nun im Fenster Netscape Message Center sichtbar.
Klicken Sie auf diesen Eintrag. Wenn Sie diskutieren wollen, missen Sie nhun Newsgroups abonnie-
ren. Klicken Sie mit der rechten Maustaste auf Ihren Newsserver und wahlen Sie aus dem folgen-
den Men den Eintrag Subscribe to Discussion Groups ...

5. Im Fenster Communicator: Subscribe to Discussion Groups werden lhnen auf der Seite All
Groups die angebotenen Diskussionsgruppen angezeigt. Offnen Sie den Ordner Schule und abonnie-
ren Sie alle Gruppen, indem Sie in der Spalte Subscribe auf den kleinen Punkt klicken.

!5 Hier kann spater auch der Name Ihres Servers stehen, wenn er im DNS bekannt ist; d.h. Ihr Provider mul3 seinem Nameserver
den Namen lhres Servers mitgeteilt haben.
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Klicken Sie abschlieRend OK.
6. Ihr Mailclient verbindet sich mit dem Mailserver und zeigt die abonnierten Newsgroups an. Doppelklik-
ken Sie zum Diskutieren eine Newsgroup. Es 6ffnet sich ein Fenster, das Ihnen vom Email-Client be-

kannt sein durfte.

7. Schreiben Sie einen Beitrag. Klicken Sie New Msg und verfassen Sie den Beitrag in Analogie zum
Schreiben einer Email. Klicken Sie abschlieRend auf Send.

8. Kilicken Sie zum Aktualisieren der dargestellten Newsgroup auf Get Msg. lhr Beitrag wird nun ange-
zeigt, wenn Sie lhn anklicken.

9. Zum Beantworten eines Beitrags klicken Sie Reply. Sie kénnen nun entscheiden, ob die Antwort per
Email (Reply to Sender) an den Absender oder fir alle sichtbar an die Newsgroup gesendet werden
soll (Reply to Group). Wahlen Sie die zweite Methode.

10. Schreiben Sie eine Antwort und klicken Sie abschlieRend Send.

11. Klicken Sie zum Aktualisieren der dargestellten Newsgroup auf Get Msg. Die Antwort wird unter dem
betreffenden Beitrag einsortiert.

12. Verfassen Sie weitere Beitrage und Antworten, testen Sie verschiedene Optionen und Benutzerprofile.

[]




